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Introduction to AURICAL Visible Speech
and the Counseling and Simulations Module

1.1

AURICAL Visible Speech
AURICAL Visible Speech (AVS) is a desktop or wall-mounted advanced 4-channel frequency analyzer that wirelessly transfers measurement data to a PC via Bluetooth. The four channels are
used for measuring the sound pressure level close to a client’s eardrum as well as outside the
ear by the pinna for both ears simultaneously. In this way, AVS enables you to perform true
binaural measurements providing you with valuable information when you adjust Hearing
Instrument settings in the suppliers’ fitting software.
AVS cannot be used without the OTOsuite Counseling and Simulations Module. When you have set up AVS for testing,
install the relevant software on your PC. When the PC application has been installed, run the Counseling and Simulations
Configuration Wizard and you will be able to connect to AVS.
AVS integrates closely with the latest generation of Otometrics test devices by offering real time presentation of test results and full test control directly from a PC with comprehensive user interface.

1.2

Counseling and Simulations
Counseling and Simulations provides a tool for operating AURICAL Visible Speech,
AURICAL SpeechLink 100 or AURICAL FreeFit, which are advanced 4-channel frequency analyzers that wirelessly transfer measurement data to a PC via Bluetooth.
Via Counseling and Simulations, you can measure the sound pressure level close to
a client’s eardrum as well as outside the ear by the pinna for both ears simultaneously. In this way, Counseling and Simulations enables you to perform true
binaural measurements that without a doubt will help you improve hearing instrument fitting.
Counseling and Simulations, AURICAL Visible Speech and AURICAL FreeFit cannot be used without OTOsuite. When you
have installed the PC application, and run the Configuration Wizard, you will be able to connect to Counseling and Simulations with either AURICAL Visible Speech or AURICAL FreeFit.
Counseling and Simulations integrates closely with the latest generation of Otometrics test devices by offering real time
presentation of test results and full test control directly from a PC with comprehensive user interface.

1.3

AURICAL Visible Speech interfacing with the Counseling
and Simulations Module
The Counseling and Simulations Module is designed to operate with either AURICAL Visible Speech, AURICAL SpeechLink
100 or AURICAL FreeFit as the test device (produced by Otometrics).
AURICAL Visible Speech, AURICAL SpeechLink 100 or AURICAL FreeFit is controlled directly from the Counseling and Simulations Module.

Otometrics - AURICAL Visible Speech
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1.3.1

Bluetooth
AVS/SpeechLink 100/FreeFit connects with the Counseling and Simulations Module via BluetoothTM. Bluetooth is a wireless communication standard, which allows devices such as computers, PDAs, mobile phones and headsets to communicate
and send data to each other in real-time, without the need for wires or cables to link the devices together. Devices can
typically communicate at ranges of up to 10 metres (approximately 33 feet).

1.4

Intended use

1.4.1

AURICAL Visible Speech and the Counseling and Simulations Module
AVS is intended for audiologists, hearing instrument dispensers, ENTs, speech therapists and other health care professionals. The intended use is that the user is able to visualize the amplified signal recorded in the ear(s) of persons with a
hearing loss in order for the user to have an objective basis for adjusting the Hearing Instrument settings. Note also that
AVS is designed for use in combination with NOAHlink - HIMSA’s wireless hearing instrument programming device. See Fitting AVS with NOAHlink ► 80.

1.5

About this manual
This is your guide to installing, calibrating and using AURICAL Visible Speech and to using Counseling and Simulations. It
also introduces you to the key features of the device and the software, as well as to working scenarios for performing tests
and viewing and printing test results.
We strongly recommend that you read this manual carefully before using your AVS and your Counseling and Simulations for
the first time.

Note • If you are using the Counseling and Simulations Module with NOAH, we recommend that you be familiar
with the screens and functions provided in NOAH.

Note • If you are using FreeFit with Counseling and Simulations, you can use this manual for information about
how to use Counseling and Simulations. For information about the FreeFit device, see the AURICAL FreeFit and
Probe Microphone Measurements user manual.

After you install OTOsuite, you can find OTOsuite manuals and related documentation on your PC. In the Start menu,
open OTOsuite Manuals, which contains an overview with links to all manuals.

1.5.1

Installation
Unpacking and installing AVS and the Counseling and Simulations Module ► 69 and Assembly and installation ► 74
contain a full description of unpacking instructions, and how to assemble the device.
For instructions on installing OTOsuite, see the OTOsuite Installation Guide, which you can find on the OTOsuite installation medium (disk or memory stick).

1.5.2

Safety
This Guide contains information which must be followed to ensure the safe performance of AVS. Local government rules
and regulations, if applicable, should also be followed at all times.

8
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Safety information is stated where it is relevant, and general safety aspects are described in Safety - AURICAL
Visible Speech and the Counseling and Simulations Module ► 89.

1.5.3

Training
It is recommended that you read this guide and try out test scenarios before you start operating AVS so that you are familiar with both the device and the software program before testing a client.

1.6

Typographical conventions
The use of Warning, Caution and Note
To draw your attention to information regarding safe and appropriate use of the device or software, the manual uses precautionary statements as follows:

Warning • Indicates that there is a risk of death or serious injury to the user or patient.

Caution • Indicates that there is a risk of injury to the user or patient or risk of damage to data or the device.

Note • Indicates that you should take special notice.

1.6.1

Navigation
Menus, icons and functions to select are shown in bold type, as for instance in:
•

Click the Set options icon on the toolbar or select Tools > Options...

Otometrics - AURICAL Visible Speech
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Powering AURICAL Visible Speech and
connecting the device to OTOsuite

2.1

Powering AVS
Device
•

AVS is powered by a battery. See Batteries ► 12.

Charger
•

The AVS charger is connected to a mains adapter, which is connected to the electrical power outlet. See Powering
the charger ► 11.

It is recommended that you leave AVS in the charger when you are not using it so that the device is always ready for use.
See the following descriptions for powering.

2.2

Powering the charger
Powering the charger
Caution • To power the charger, you must use an IEC/UL 60601 or IEC/UL 60950 certified power
adaptor supplying 9 V DC, min. 300 mA and with a maximum available output of 15 W. The adapter
supplied with the unit meets these specifications.

1. Plug the DC plug of the DC power adapter (A) into the DC inlet on the charger (see below).

A. DC plug

Otometrics - AURICAL Visible Speech
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2. Select the appropriate mains plug adapter from the “Mains plug adapter kit” supplied with the AVS to fit your mains
outlet, and slide it into the mains adapter until it clicks.
3. Connect the DC power adapter to a mains power outlet. When you switch on power to the charger, the green power
indicator on the charger front is lit.

2.3

Turning off the charger
To turn off the charger, unplug the power adapter from the mains power outlet, or switch off the power outlet.

Caution • Electrical equipment must be positioned so that there is easy access to disconnect the power supply
from the mains.

2.4

Batteries
Caution • Use only the battery types listed in Technical Specifications - AURICAL Visible Speech ► 93.

NiMH rechargeable batteries
AVS is delivered with a rechargeable NiMH battery. Before you can operate AVS, insert the battery in the AVS (see Inserting the battery ► 12).

First time charging
Charging applies only if you use a rechargeable battery.
The rechargeable NiMH battery may not be charged when you receive the AVS. You may therefore have to charge the battery for some hours, and preferably overnight, before you switch on the AVS.
A fully discharged battery must be charged in the AVS charger for 14 hours before it is fully charged.
A new rechargeable battery may not reach full capacity until it has been recharged a couple of times.
Alkaline batteries
If required, the AVS can be powered by a non-chargeable Alkaline battery.

Warning • If you use the AVS with an Alkaline battery, always switch off the power supply to the charger. Even
though charging will normally be switched off automatically when an Alkaline battery is detected, charging an
Alkaline battery may cause the battery to leak and cause damage to the AVS.

2.5

Inserting the battery
1. Remove AVS from the charger.
2. To insert the battery, press the grooved area on the front of the battery cover at the top of the AVS and gently tip the
lid backwards off the compartment.

12
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A. Press to open

3. Insert the battery as shown below. A label inside the battery compartment shows which way the battery fits.

4. Put the battery cover back in place.

2.6

Switching on AVS
To switch on AVS, press and hold the On/Off button on top of the device until the status indicator light turns on. The
status indicator will light for about 3 seconds, and then go into periodical flashing. The various light indications are
described in Charging and battery status ► 14

A. On/Off button

2.7

Switching off AVS
To switch off AVS, press and hold the On/Off button on top of the device until the status indicator light turns off.

Otometrics - AURICAL Visible Speech
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A. On/Off button

2.8

Charging, Powering and Connection Status
It is recommended that you place AVS on the charger when it is not in use. This will ensure that the batteries are always
charged, and the charger is a convenient cradle for AVS.

Warning • Do not attempt to use AURICAL Visible Speech with clients while it is placed in the charger unit, unless
you have the AURICAL Aud speaker unit with a medically isolated power supply unit.

The status indicator changes color to indicate the powering and charging state of the AURICAL Visible Speech.

A. Status indicator

The indicator can show one steady color, one flashing color, or alternating colors to provide additional information.

2.8.1

Charging and battery status
Note • If the indicator status is flashing with two or more alternating colors, see the descriptions for both colors.

Amber, steady
•

AVS is turned off and charging.
Note that charging is automatically discontinued after 14 hours of charging. This is done to ensure that batteries are
not being over-charged.

Amber, flashing
•

14

(alternating with another color)

In the charger: AVS is turned on and charging.
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•

Out of the charger: AVS is turned on but the battery status is low. AVS can be used in this mode for a period of time,
but needs to be recharged or fitted with a new Alkaline battery as soon as possible.

Green, steady
•

AVS is not charging, and is turned off.
AVS enters this state after 14 hours of continuous charging or if an Alkaline battery has been detected.
Note that charging is resumed if the device is removed and then placed on the charger again.

Red, flashing (faster than every 2 seconds)
•

In the charger: An error has occurred in AVS during charging.
Most likely, the battery is defective. Replace the battery and try charging again. If the error continues, contact your
supplier.

“Battery low” indication in the Counseling and Simulations module
When a battery low state is detected in AVS, this is signalled by the AVS status indicator with the amber color described in
Amber, flashing (alternating with another color) ► 14.
If AVS is connected to Counseling and Simulations, a “Battery low” indication is shown in the bottom right corner of the
screen. Also, a bubble notification will appear.
When the “Battery low” warning occurs, there will be approximately ½ hour of continuous use left. The time left will, however, vary depending on how AVS is used, and the state of the battery. If the rechargeable battery is fairly old, the time left
will be shorter than for a new battery.

Note • For Alkaline batteries, the “Battery low” indication may not leave as much testing time as a rechargeable
battery would.

2.8.2

Connection status
Note • If the indicator status is flashing with two or more alternating colors, see the descriptions for both colors.

Green, flashing (every 2 seconds)
•

In the charger: AVS is not charging, and a Bluetooth connection with OTOsuite has been established.

•

Out of the charger: AVS is turned on but not connected.

Green, flashing (faster than every 2 seconds)
•

In the charger: AVS is not charging, and AVS is communicating with OTOsuite.

Blue, flashing (every 2 seconds)
•

AVS is turned on and a Bluetooth connection with OTOsuite has been established. Battery status is OK.

Blue, flashing (faster than every 2 seconds)
•

AVS is turned on and is communicating with OTOsuite. Battery status is OK.

Otometrics - AURICAL Visible Speech
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Red, flashing (faster than every 2 seconds)
•

Out of the charger: An error has occurred in AVS. Wait for the unit to power off automatically or remove the battery
to turn off the unit. Power on the unit again. If the error continues, contact your supplier.

Red, flashing (every 2 seconds)
•

2.9

AVS has a Bluetooth initiation error. Press the On/Off button or remove the battery to turn off the unit. Power on the
unit again. If the error continues, contact your supplier.

Establishing a connection between AVS and
Counseling and Simulations
When you use Counseling and Simulations for the first time, run the configuration wizard to set up the connection
between AVS and Counseling and Simulations. (See Configuring the Counseling and Simulations Module ► 85)

2.9.1

Connecting to AVS
After you have configured Counseling and Simulations for the first time, if AVS is turned on when you open the Control
Panel in Counseling and Simulations, then AVS will connect to Counseling and Simulations automatically. Otherwise, you
can connect to AVS as follows:
1. Switch on AVS (see Switching on AVS ► 13).
2. In Counseling and Simulations, on the toolbar, click on Control Panel.
3. In the control panel, click Connect.
The Control Panel relating to the test device and the selected test type is shown in the left side of the screen.

Firmware update - AVS
If your OTOsuite has been updated and a new Firmware update has become available, a message will appear.
Follow the on-screen instructions.

2.9.2

Reconnecting to a test device
If the control panel for a test type is shown, and communication with the selected test device is interrupted, a message
appears stating that there is no longer connection to the device.
•

Click the Connect button on the Control Panel to reconnect to the selected test device.

•

Alternatively, you can run the configuration wizard to select a different device, if one is available (see Configuring the
Counseling and Simulations Module ► 85).

AVS transmits test data to Counseling and Simulations when communication is active. Since AVS does not have any storage
capability, you may lose data if communication is interrupted. Run the test once more, if necessary.

Test devices with data storage capability
For test device with storage capability, such as OTOflex 100, as a general rule communication between Counseling and Simulations Module and the test device is defined by the test device. This means that the client folder currently shown on
the test device will be transferred automatically to Counseling and Simulations Module.
This also means that if the test device is testing and communication with Counseling and Simulations Module is interrupted, the test data remains in the test device. Data will be synchronised with Counseling and Simulations Module data
when communication is reestablished.
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Preparing AURICAL Visible Speech and
the Counseling and Simulations Module for testing
Preparation is an important part of Counseling and Simulations Module testing. It is time-saving for both you and the client
if the environment, the client and the test device setup and program are ready for the test.

3.1

Preparing the test environment
Before you start testing, make sure that the test environment is conducive to testing. This includes factors such as selecting
a test location where environmental influence on test results is minimal, and setting up equipment such as speakers, test
device and computers.

3.1.1

Requirements to noise in the test environment
Counseling and Simulations testing does not require a quieter testing environment than does other traditional Real Ear
Measurement systems.
Although Counseling and Simulations testing is designed for use in a regular dispensing office environment, the test environment should in some cases be adapted to suit the specific test types.
•

Make sure that the test environment is as quiet as possible. The quieter the room is, the more accurate your testing
will be.
Measurements of peak levels will be influenced by any sounds louder than the presented test signals. Even extremely
brief sounds may impact the measurements.
It is therefore important that the environment is well controlled to prevent any unforeseen influence.

•

Check that testing is not being done under an air conditioner or in front of a fan or ventilator.

•

Counseling and Simulations tests
A quiet location is always conducive to simulation and testing, both with regard to noise and to making sure that the
client is not influenced by factors other than the test itself and the person performing the test.

For the Speech Mapping measurements it is very important that the measurements are not influenced by sounds or noise
relating to anything else than the presented test signals.

3.2

3.2.1

Preparing AURICAL Visible Speech
•

Make sure the cables of the test equipment are connected correctly.

•

Launch OTOsuite and the Counseling and Simulations Module on the PC.

•

Switch on AVS.

•

Check the battery status of AVS to make sure that the device is ready for testing. See Charging and battery status ►
14.

•

Fit silicone test tubes to the probes you will be using. See Fitting silicone tubes on the probes ► 78.

•

Perform a tube calibration if you have fitted AVS with new silicone tubes. See Tube calibration ► 21.

Connecting the cables of the test equipment
Connect the cabling of the computer and various accessories as shown in the following illustration.

Otometrics - AURICAL Visible Speech
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A. Bluetooth adapater
B. SoundHub 100
C. Headphones

D. Headphones
E. Table microphone
F. Optional speaker system from GN Otometrics A/S

Note • The sound card setup set by the OTOsuite Installation may change the default Windows sound card setup.
To check the default setup, see “Sounds” in the Windows Control Panel.

3.2.2

Positioning test equipment
When you position the test equipment, placing the equipment in specific positions will facilitate measurements and testing. The following illustration is a good guideline for this.

18
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A. Loudspeaker
B. PC screen
C. Subwoofer

D. Third party
E. Client
F. Dispenser

PC screen
All persons involved in the test must have a good view the PC screen.

Speakers
It is also important that nothing blocks the path between the loudspeakers and the Client.
The exact positioning of the loudspeakers is not crucial, as long as the speakers are properly calibrated.

Two speaker system for Hearing Loss Simulation and Hearing Instrument Simulation
In order to minimize variations in the measurements, a speaker angle of ±45 o relative to the Client is recommended. The
speakers should be placed at a reasonable height so that they point directly towards the Client.
The sub woofer should be placed on the floor. Its exact position is not critical.

One speaker solution
In order to minimize variations in probe microphone measurements, a speaker angle of ±0 o relative to the client is recommended.
Ideally, the speaker should be easily movable so that it can be placed in an appropriate position depending on the test - for
example, you may want to move the speaker when demonstrating the hearing instrument’s directionality features. Alternatively, you can move the client.
The speaker should be placed at a reasonable height so that it points directly towards the client.

Otometrics - AURICAL Visible Speech
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3.3

Selecting a Measurement Device
Before you use Counseling and Simulations for the first time, you must run the configuration wizard to set up your sound
devices and other preferences. You can also use the configuration wizard to connect to your AVS device for the first time.
Once you have configured Counseling and Simulations, you can use the Select Device icon on the toolbar to select an AVS
device. This is particularly useful if you have more than one device, and you switch devices often.

To select a device:
1. Click on the Select Measurement Device icon.

The AVS/SpeechLink/FreeFitpage from the configuration wizard opens.
2. Select the device you wish to use, and then click OK .
For more information about the AVS/SpeechLink/FreeFit dialog, see Configuring the Counseling and Simulations Mod-

ule ► 85

3.4

Speaker calibration
•

In any test screen in Counseling and Simulations, click Tools > Calibration > Speaker system.

•

Select the calibration method.

Using AVS, SpeechLink or FreeFit for speaker calibration
•

Before you start the calibration, position the AVS, SpeechLink or FreeFit probes in the intended client location, preferably correctly placed on your shoulders, with the probes on your ears.
This will take into account the influence of a person being placed in the sound field.

•

Turn on your device. In the calibration wizard, select the My AVS/SpeechLink/FreeFit is turned on and within reach
check box.

•

Click Next.

•

The speaker calibration results are shown on the screen.

•

Click Finish to close the wizard.

Using an external Sound Level Meter for speaker calibration
1. Before you start the calibration, position the sound level meter in the intended client location.
Turn up the volume on your sound system to a very high level.
2. Select Use an external Sound Level Meter for calibration.
3. Click Next.
4. Enter the level that you want to calibrate the speakers for, and then click Next.
5. Adjust the volume of the speaker(s) using the volume slider on the screen until the sound level meter displays the
same level as you have entered for the calibration level. Click Next.
6. If you have a two speaker solution, repeat step 5 for the second speaker.
7. The calibration offset is displayed.
8. Click Finish to close the Wizard.
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3.4.1

Reference microphone calibration
Reference microphone calibration must only be performed by a certified service technician and requires a password.

3.5

Headphone calibration
You can adjust the output of the counseling headphones if desired. The Headphone Calibration wizard assists you to compare the output from a calibrated audiometer with the output from the counseling headphones, and to adjust the headphone output.

To adjust the output of counseling headphones:
Click Tools > Calibration > Headphones.
Follow the instructions in the wizard.
This will ensure that the simulation sound files are presented at fairly accurate levels.

3.6

Tube calibration
It is recommended that you perform a tube calibration whenever you change silicone tubes on the probe. The purpose is
to calibrate the acoustic influence of the individual tubes to the frequency response.
1. Fit a new silicone tube on the probe. See Fitting silicone tubes on the probes ► 78.
2. Insert the free end of the silicone tube in the test cavity in the probe.

A. Silicone tube
B. Tube calibration test location

3. Ensure that AVS is connected to Counseling and Simulations.
4. Press the On/Off button briefly on AVS.
The Probe Tube Calibration dialog box appears and the calibration starts automatically. The calibration sounds are
played through the loudspeakers.
The calibration is shown on the screen as it progresses and stops automatically.
The calibration window closes automatically when calibration is completed successfully.
If the tube calibration fails due to noise or unstable signal conditions, try to eliminate sources of ambient noise, or increase
the input level for instance by holding the probes closer to the loudspeakers.

Otometrics - AURICAL Visible Speech
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Alternatively, you can click the Show Tube Calibration icon to open the Probe Tube Calibration dialog box.

If you select the Show for new client field in the Probe Tube Calibration dialog box, the dialog will open at the beginning
of every client session. (Note that the setting will not be saved for future sessions unless you save your settings in the
Options window. For more information about saving default settings and user tests, see the Getting started with OTOsuite
section in the OTOsuite User Manual.)

3.7

Preparing the client

3.7.1

Hygienic precautions
It is important that hygienic precautions are taken to protect the client from cross-infection.

3.7.2

•

Be sure to follow any established infection control procedures for the setting in which you are working.

•

To prevent cross-infection, use new silicone tubes when you test the next client.

Inspecting the client’s ear(s)
1. Position the client so that you can easily access the client’s ear(s).
2. Grasp the pinna and gently pull it back and slightly up and away from the client's head.
3. Inspect the ear canal and make sure that you can see the ear drum.
If you can see apparent narrowing of the ear canal, it may be blocked by ear wax or debris, or it may not be straight.
4. If the ear canal is blocked, for instance by ear wax or debris, the outcome of the procedures may be affected.
Clean the ear canal if required.

3.7.3

Fitting AVS and probes on the client
It is important that the probe tube for every measurement is inserted correctly and consistently in the ear of the client.
1. Place the black marker ring at the recommended distance from the tip of the probe tube.
Recommended distances are
men:

27 mm

women:

27 mm

children:

20-25 mm

In the case of children, otoscopy is especially recommended to prevent contact with the eardrum.
1. Place the client as shown in Connecting the cables of the test equipment ► 17.
The position of the client must provide a clear view of the screen so that you can discuss the illustrations and measurements shown.
2. Place the ear cords with the probes over the ears of the client. Adjust the length of the ear cords, if required.
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3. Make sure that you use clean probe tubes, free of cerumen (ear wax).
4. Be careful!
Carefully insert the probe tube into the ear canal until the black marker ring reaches the intertragal notch.
5. You can now proceed with The Counseling and Simulations Module Workflow ► 45.

3.8

Training
In order for you to feel well prepared and confident before you receive clients for testing using the Counseling and Simulations Module, try out the Workflow descriptions. They provide you with scenarios on how to use the Counseling and
Simulations Module both as a testing tool as well as an information process tool.
The goal of the Counseling and Simulations Module Workflows is to describe a client session with suggestions on how you
can introduce both the Client and third party to the various hearing features and demonstrate the benefits of hearing
instruments.
•

The test screens are described in Navigating in the Counseling and Simulations Module ► 25.

•

Workflows are described in The Counseling and Simulations Module Workflow ► 45.

Otometrics - AURICAL Visible Speech

23

3 Preparing AURICAL Visible Speech and the Counseling and Simulations Module for testing

24

Otometrics - AURICAL Visible Speech

4

Navigating in the Counseling and Simulations Module
The general functions for navigating in the main window are described in the OTOsuite User Manual.

Counseling and Simulations Module elements

A. Menu bar
B. Counseling and Simulations toolbar
C. Overlays box/Legends box

D. Navigation panel
E. Work area

Screen descriptions
You will find descriptions of the test screens and how to use and view them in:

The Hearing Loss Simulator screen ► 35
The Hearing Instrument Simulator screen ► 37
The Speech Mapping screen ► 39

4.1

The Counseling and Simulations Module menu system and toolbar
The Menu bar is located at the top of the window. Some of the menu items are also available as icons.
The icons available in the Toolbar depend on the test functions included in your OTOsuite.
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General icons

The general OTOsuite menu system and toolbar are described in the OTOsuite User Manual.

Counseling and Simulations icons

Note • The selections available depend on the test function you have selected.

The menu selections and toolbar specific to the Counseling and Simulations Module are described below.

Edit menu
Reload Audiogram
Click to reload the original audiogram.

View menu
HL
SPL
Toggle between HL and SPL view
Click the icon in the toolbar to toggle between the views, or click the menu item to select the
view.
Select HL to view the Hearing Level view. Select SPL to view the Sound Pressure Level view.
Audiograms are as a rule measured in HL. When you select the SPL view, the audiogram values are
converted from HL to SPL. Counseling & Simulations applies a static conversion for a sound field audiogram to all types of audiograms, and adds a monaural correction of 2 dB.
The formula is:
Simulators: Threshold [dB SPL] = Threshold [dB HL] + Sound field RETSPL (ISO 389.7)
Speech mapping: Threshold [dB SPL] = Threshold [dB HL] + Sound field RETSPL (ISO 389.7) + KEMAR
(0 degree) + 2 dB

Left
Select to view the graph relating to the left ear.
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Right
Select to view the graph relating to the right ear.

Left + Right (Both)
Select to view the graph relating to both ears.

Overlays
Click the menu item to view a sub-menu where you can select the overlays you wish to display. (See
The Overlays box ► 43).

Legends
(Speech Mapping only)
Select the Legends menu item to display the Legends box. When Legends is not selected, the Overlays box is displayed.

Show/hide curve legend
Clicking the icon switches between displaying the Legends box and the Overlays box.

Show Text

Show text to read
Click to select text file for reading aloud. See Using text files for reading aloud ► 32.

Show Predicted Aided Audiogram
(Hearing Instrument Simulator only)

Display the Predicted Aided Audiogram
Click to display the predicted aided audiogram when you simulate the effect of a hearing instrument. See The Predicted Aided Audiogram view ► 38.
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On Top Window
(Speech Mapping only)

Switch to On Top mode
Select to view the Speech Mapping screen in a down-scale version for use on top of other applications. Click the icon or the X-box in the top right corner to return to normal viewing. See Suggested Speech Mapping On Top mode workflow ► 59.

Measurement menu
Stop (Esc)
For stopping the test/simulation progress. Select to stop or click the Pause or Stop icon on the Control Panel.

Start (F5)
For starting the test/simulation progress. Select to start or click the Start icon on the Control Panel.

Record
Select to record speech signal from third party.

Snapshot
Click to make snapshot.

Repeat
Select to repeat the sound track presented.

Snapshot Mode
Select to enter Snapshot Mode. See The snapshot function ► 41
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Reset Peak Hold
Select to reset peaks. See Measurement in Speech Mapping ► 35).

File
For selecting a sound track from a file. See Signal source ► 31).

CD Player
For selecting a sound track from a CD. See Signal source ► 31).

Live
For selecting live presentation of sound. See Signal source ► 31).

Recording
For selecting presentation of sound from a recording. See Making and using custom recordings ►
32).

Talk Over
For the test operator to talk to the client via the microphone. The test is paused while the button is
activated. The test is resumed when you click the button again.

Tools menu
Calibration
Speaker System

For calibrating the speaker system and headphones used in the test setup. See Speaker calibration
► 20.

Headphones

For adjusting the output of the counseling headphones. See Headphone calibration ► 21.

Tube

(Speech Mapping only)
For calibrating the probe silicone tubes used during testing. See Tube calibration ► 21.
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Select Device
Click the icon to open the Select Device window, which you can use to select a FreeFit device. This is
useful if you have more than one device. See also Selecting a Measurement Device ► 20.

Additional icons
Show audiogram
Click to show audiogram for the relevant ear.

Show Tube Calibration Wizard
Activates the tube calibration wizard. See Tube calibration ► 21

4.2

Selecting Speakers or Headphones
In the Counseling and Simulations configuration wizard, you canspecify which speaker or speakers to use for Counseling
and Simulations. (See Configuring the Counseling and Simulations Module ► 85.)

Note • For the Hearing Loss Simulator test screen and the Hearing Instrument Simulator test screen, you can
select either Speaker or Headphone as the sound output device. By default, the Hearing Loss Simulator is set to
use speaker output, and the Hearing Instrument Simulator is set to use headphone output.

To change the sound output settings, click Tools > Options to open the Options window. You can change the setting for
the relevant test screen under Counseling and Simulations > Hearing Loss Simulator or Hearing Instrument Simulator

> Measurement > Misc. > Sound Output.

4.3

The Counseling and Simulations Module Control Panels
The Counseling and Simulations Module Control Panels are available in all test screens.
The Control Panel is divided into three main sections, where you can select and adjust various settings.
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•

The Signal Panel
The Signal Panel contains player controls, which includes selecting sounds and starting and stopping measurements or
simulations. See Signal source ► 31.

•

The Simulation Panel (HLS, HIS)
The Simulation Panel contains controls used actively during simulations/illustrations, such as switching between simulation modes. See Simulation ► 33.

•

The Measurement Panel (Speech Mapping)
The Measurement Panel contains controls used actively during measurements, such as controlling the measurement
curves. See Measurement in Speech Mapping ► 35.
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•

4.3.1

The Volume Panel
The Volume Panel contains the controls for adjusting volume and microphone sensitivity. See Volume ► 35.

Signal source
Selecting the signal source
There are two options for playing calibrated sounds through the Counseling and Simulations
Module:
•

The sound files supplied in c:\program files\gn otometrics\otosuite\SoundLib\

•

Music CDs of your own choice. This does not include data CDs with music files.

The Signal box lets you select the signal to present to the client:

File
•

Use the files available. Press the File icon and select the signal file from the drop-down Title list.

•

Press the CD icon and select the CD-track from the drop-down Title list.

•

When you present a Live signal, you can select a text to read from by clicking the Text icon on
the toolbar.

CD

Live

When you use the Live signal, for instance in Speech Mapping, any sound files must be played
through an external media player. When you do so, make sure that you adjust the level according to the VU meters above the graph area.

Recording
•

Instead of using a prerecorded speech sound, you can use a speech sound familiar to the client.
To do so, make a recording, for instance of the voice of the third party. This also allows for a
higher degree of repeatability than by using a live voice. See Making and using custom recordings ► 32.

Playing the signal
1. Select the signal source.
2. If you want the signal to repeat continuously until you press Pause or Stop, check the Loop
signal check box.
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3. Click Play.
4. If required, click Pause or Stop.

4.3.2

Making and using custom recordings
In the Counseling and Simulations Module, you can always make customized recordings for use in the different exercises.
The impact of using a familiar voice as signal is a powerful way of demonstrating deficits of hearing loss, or the improvements with amplification.

Making the recording
1. Click the Record sound source button on the Control Panel.

2. Make sure that appropriate reading material is readily accessible. It is recommended that familiar texts
such as newspaper articles are used, so that the talker does not have to rely on improvisation.
3. In Counseling and Simulations you can store a predefined text for easy access. See Using text files for
reading aloud ► 32.
4. Keep the table-top microphone at a distance of approximately 30 centimeters (10 inches) from the
mouth, while you or a third party talk at a level so that the control panel VU-meter is kept steadily at
the pre-defined (marked) level (default 65 dBA SPL).
5. When you or the third party manage to keep the voice at this level, start the recording, and read the
text keeping the strength at the same steady level throughout the recording.
About 10-15 seconds of recording may suffice. If needed, you can click the Pause button at any time to
interrupt/continue the recording.
6. Click Stop, and the recording is stored and can be accessed throughout the rest of the session.

Using the recording
You can access the recorded sound file from the Hearing Loss Simulator, the Hearing Instrument Simulator and the
Speech Mapping Module.
1. To use the recorded sound file, click Record sound source button.

2. Click Play.

4.3.3

Using text files for reading aloud
See The Rainbow Passage ► 87.
You can create your own text files and personalize the type font.
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Creating a text file
You can create your own archive of text files. To do so:
1. Click the Show text to read icon on the toolbar.
2. Type or copy and paste your text into the pop-up window.
3. Select File > Save as and save the file under a name of your choice.

Personalizing the type font
You can customise the appearance of the text file. For instance you may choose to step up the type font size to make it
easier to read.
•

To do so:
Select Tools > Option, click General and Text Font.

or
Click the Show text to read icon on the toolbar, and select Format > Font...

•

Make the required changes and click OK.
The changes will also apply the next time you open Counseling and Simulations.

Using a text file
1. To use a text file click the Show text to read icon on the toolbar.
2. The text file most recently used or saved appears in a pop-up window.
3. To close the file select File > Close or click the X in the top right corner of the file window.

4.3.4

Simulation
The buttons that are available in the Control Panel depend on:
•

The Speaker Channel setting in the Configuration Wizard (Left or Right for one speaker or Left + Right for two speakers)

•

The Sound Output setting in Options (Headphone or Speaker). (See Selecting Speakers or Headphones ► 30.)

Hearing Loss Simulator - with headphones or two speakers
Play the selected signal. While the signal plays, you can switch between presenting the signal in the following modes:
•

without hearing loss simulation, or

•

with hearing loss simulation for both ears.
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Note • When you use headphones or two speakers, you can use the volume slider to lower the volume of one
speaker or headphone, in order to demonstrate one ear at a time.

Hearing Loss Simulator - with one speaker
Play the selected signal. While the signal plays, you can switch between presenting the signal in the following modes:

or

•

without hearing loss simulation, or

•

with hearing loss simulation for selected ears. (If you select Both, the hearing losses
from both ears are simulated together in the single speaker.)

Hearing Instrument Simulator - with one speaker
Play the selected signal. While the signal plays, you can switch between presenting the signal in the following modes:
•

without hearing instrument simulation, or

•

with hearing instrument simulation for selected ear.

or

Hearing Instrument Simulator - with two speakers
Play the selected signal. While the signal plays, you can switch between presenting the signal in the following modes:
•

without hearing instrument simulation, or

•

with hearing instrument simulation for both ears.

Hearing Instrument Simulator - with headphones
Play the selected signal. While the signal plays, you can switch between presenting the signal in the following modes:
•

without hearing instrument simulation, or

•

with hearing instrument simulation for selected ear or both ears.

or

Talk over
Click this button and speak into the microphone. If a sound file is playing, this file is muted, and your voice
will be transmitted to the headphones.
Active only when Options > Hearing Instrument/Hearing Loss Simulator > Sound Output is set to Headphone.
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The Microphone sensitivity level setting controls the level of the talk-over.

4.3.5

Measurement in Speech Mapping
•

Reset Peak Hold
During a measurement, the measurement curve may show some unusually high peaks. These peaks can be caused by noise, for instance if the
client inadvertently touches the probe.
You can reset these peaks by clicking Reset Peak Hold on the Measurement Control Panel. A new peak curve will be generated.

•

Clear All Curves
Click Clear All Curves to delete all curves from the selected graph
areas. This function is active only in idle mode.

4.3.6

Volume
Volume control for headphones or two speakers
•

Slide the buttons along the bars to adjust.
The volume is increased/decreased in steps of 3 decibels.

L+R: The left and right sliders are locked in their relative positions and are
moved simultaneously.

Note • The speaker/headphone calibration is only valid when the
Master sliders are in the center position. The calibrated position is
indicated by the green light indicators on the sliders.

Volume control for one speaker
•

4.4

Slide the button along the bar to adjust.

The Hearing Loss Simulator screen
See also

The Hearing Loss Simulator ► 47
Suggested HLS workflow ► 48.
The Hearing Loss Simulator screen provides you with a view of the Client’s hearing loss versus normal hearing depending
on the state of the simulator, i.e. whether normal or simulated mode has been selected. This will enhance the sound
demonstration of what the hearing loss implies.
You can use a number of overlays to further demonstrate/emphasize the different aspects of the Client’s hearing loss. (See
The Overlays box ► 43).
In the toolbar you can switch between an HL and an SPL view.
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4.4.1

Normal mode

A. Status indicator
B. Normal HTLs
C. Client's HTLs (inactive)

4.4.2

D. Speech Banana and Speech Letters (default overlays)
E. Unusable Area (default overlay)

Simulated mode

A. Area of opportunity
B. Predicted UCL (no symbols)
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C. Measured UCL (symbols)
D. Unusable Area (default overlay)
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4.5

The Hearing Instrument Simulator screen
See also

The Hearing Instrument Simulator ► 51
Suggested HIS workflow ► 51.
The purpose of the Hearing Instrument Simulator screen is to visualize the difference in audibility with and without amplification.
In the following examples, the graphs show the spectrum without amplification (normal mode) and with amplification (simulated mode).
To convince the Client of the disadvantage of using only one hearing instrument as compared to using two (binaural), amplification is shown in the right ear in this example.
You can use a number of overlays to further demonstrate/emphasize the different aspects of the Client’s hearing loss. (See
The Overlays box ► 43).
In the toolbar you can switch between an HL and an SPL view. You can also select the Predicted Aided Audiogram view by
clicking the icon in the toolbar.

4.5.1

With versus without Hearing Instrument Simulation - HL

A. Status indicator
B. Client’s HTLs (inactive)
C. Customized Speech Banana and Speech Letters

(default overlays)

Unusable Area (default overlay)
Counseling and Simulations spectrum (default
overlay)
G. Predicted UCL (no symbols)
E.
F.

D. Measured UCL (symbols)
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4.5.2

With versus without Hearing Instrument Simulation - SPL

A. Measured UCL (symbols)
B. Predicted UCL (no symbols)

4.5.3

C.

Client’s HTLs

The Predicted Aided Audiogram view

A. Client's HTL
B. Predicted Aided Audiogram
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You can select the Predicted Aided Audiogram view as an alternative to using the customized speech banana for hearing
instrument simulation. This view is an additional counseling tool that allows for visualization of improved access to the
speech sounds.
When you display an audiogram with the Predicted Aided Audiogram view, the traditional speech banana is displayed,
instead of the customized speech banana. When you simulate use of a hearing instrument, the audiogram is displayed with
a lowered threshold, to demonstrate that the client would have access to a greater part of the sound signal, and thereby
improved access to the speech banana.
The estimated aided threshold curve (the Predicted Aided Audiogram) is based on the gain rules used by the hearing
instrument simulator. The displayed values are the client’s thresholds minus the target insertion gain.
Use of the Predicted Aided Audiogram view returns to using the speech banana in the way that one might counsel when
using a static, printed audiogram.
The customized speech banana should be used to explain the concept of reduced dynamic range and the purpose of compression in hearing instruments.

4.6

The Speech Mapping screen
Note that Speech Mapping in Counseling and Simulations can be used with either AVS, SpeechLink or FreeFit.
See also

Speech Mapping ► 53
Suggested Speech Mapping workflows ► 53.
When you select the Speech Mapping screen, the work area shows only the graphs based on the Client’s audiogram.
When you play a signal file, this is shown as a curve on the graph. The curves are listed in the Legend box and are displayed
in different colors.
This screen is best viewed in SPL. In the toolbar you can switch between an HL and an SPL view.

Before measuring

A. Client’s UCL
B. Customized, Speech Banana (default overlays)
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Measuring mode

A. Client’s UCL
B. Live peak curve

4.6.1

C. Falling peak curve
D. Client’s HTLs

Viewing measurements

A. Peak curve measurements. Selected curve is highlighted.
B. Normal audiogram overlay (useful in SPL)
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4.6.2

The snapshot function
•

Select Snapshot mode in the Control panel.
When you work in Snapshot mode the measurement is captured as an average of the live FFT signal
over a very short time period at the moment when a user input triggers the measurement.

•

Each time you click on the Snapshot icon, a new snapshot of the signal is captured.

The Snapshot is recommended to be used when there is a need to capture a measurement at a very specific time in relation to Hearing Instrument (HI) behavior. You can for instance use the Snapshot to capture HI noise reduction functionality
over time, or to capture different measurements of HI directionality functionality related to the listening position of the
client towards a sound source.
The captured Snapshot curve can either be displayed as the peak hold or the short term average at the time the measurement is made. You can choose which is displayed in Options > Counseling and Simulations > Speech Mapping >
Curve settings > Measurement Type.
The Snapshot measurement parameters are equivalent to the “Short term average” measurement. And the Snapshot measurement is influenced by the “Spectrum response” option setting.

4.6.3

Legend
The Legend box shows the curves drawn on the graphs. When you click on a curve in the Legend box, the corresponding
curve on the graph is highlighted.

Total curve number
The total number of curves that can be recorded is 12. You can for instance record 9 curves on one ear and 3 curves on
the other ear. This means that for instance in binaural measurements you can record a maximum of 6 curves for each ear.
If you exceed the total number of curves, the oldest curve(s) will be overwritten.

Editing legend text
You can change or add to the default legend text. Click in the text to add, or mark up the text you wish to change.
To exit text editing, click outside the Legend box or press the Tab key on your keyboard.

4.6.4

Deleting curves
If, for instance, a measurement was influenced by external noise, you can delete unwanted curves.
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To delete a curve:

4.6.5

•

Click on the curve in the Legend box. The curve is highlighted on the screen.

•

Click Edit > Delete Selected Curve (or press Ctrl+Delete).

•

The curve is deleted.

On Top mode in Speech Mapping
•

From the Speech Mapping screen, activate On Top mode by clicking the On Top icon.

•

Move and scale the Speech Mapping On Top window so that you can access the hearing instrument parameters in the fitting software, and at the same time make use of the Speech-impaired tests.
The position and size of the On Top mode window will initially be the same as when it was last used. You
can also change the settings so that the left and right graphs swap positions if necessary.
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Toggle curve legend visibility
To show/hide the curve legend box, click on the Toggle curve legend visibility button in the On Top mode
toolbar.

Using the Control Panel in On Top mode
To view and use the Control Panel in On Top mode, click the Open Control Panel button in the On Top
mode toolbar.

Returning to normal viewing
•

4.7

To return to normal viewing, click on the Return to Normal View icon in the top right corner of the window.

The Overlays box

In the Overlays box you can check/un-check the check boxes to view/hide various features.
You can determine the overlays that should be applied to the graphs when the module is started (Tools > Options > Overlays).
If you wish to return to the default values, click Default.

Pictures
Shows common types of sound and where they are located in the various areas of the audiogram.

Speech Banana
Shows the area where normally spoken speech sounds appear in the audiogram, and how these sounds are affected by
the Client’s hearing loss.

Speech Letters
Shows the various letters in normal speech as they are placed in relation to the speech banana and the Client’s hearing
loss.

Severity
Shows a scaled representation of the various levels of severity for categorizing a hearing loss.
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Unusable Area
Shades the area that cannot be heard.

Customized
Shows the Client’s personal Speech Banana according to loudness equalisation principles.

Visible Speech
Spectrum used to visualize the sounds in relation to the residual dynamic range (area of opportunity), when a sound
file is played.
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The Counseling and Simulations Module Workflow
The Counseling and Simulations Module Workflow section provides you with “recipes” and inspiration to go through various scenarios for explaining and illustrating hearing loss and hearing instrument amplification.

Introduction
Introduction to the Counseling and Simulations Module workflow ► 45

The specific workflows
The Audiogram ► 47
The Hearing Loss Simulator ► 47
Suggested HLS workflow ► 48
The Hearing Instrument Simulator ► 51
Suggested HIS workflow ► 51
Speech Mapping ► 53
Suggested Speech Mapping workflows ► 53
Using a sound file for increased repeatability in Speech Mapping ► 55
Explain/repeat the audiogram using Speech Mapping ► 56

Extra features
Hearing Instrument feature demonstration: Noise Reduction ► 60
Hearing Instrument feature demonstration: Directionality ► 61
Hearing Instrument troubleshooting: Feedback ► 62

Concluding a client session
Handing over the responsibility ► 63

5.1

Introduction to the Counseling and Simulations Module workflow
The major strength of the Counseling and Simulations Module system lies in providing you with an unsurpassed tool for actively involving the Client and third party in the hearing instrument fitting process.
This is illustrated in three steps:

5.1.1

•

Involving and motivating the client ► 45

•

Counseling and Simulations as an information process tool ► 46

•

The Counseling and Simulations fitting process milestones ► 46

Involving and motivating the client
The fitting process is not limited to the sessions with the dispenser, but must also go on in between visits. The Counseling
and Simulations approach aims at motivating all parties to successfully complete the fitting process.

New hearing instrument users
Especially new users go through a first critical process of adapting to the new, amplified sounds. This is a "thousand hour"
process that requires active training, and is often experienced as a cumbersome period for the Client as well as the third
party.
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5.1.2

Counseling and Simulations as an information process tool
The goal
The goal is to introduce both the Client and third party to the hearing features of audibility, the residual dynamic range
("area of opportunity") and the speech banana.

Showing hearing instrument benefits
You can use the system for setting reasonable expectations to how the hearing instrument will perform.
If the Client understands these features, you can (visually) convince the Client that the hearing instruments will significantly improve the audibility by making soft sounds audible, speech sounds comfortable and loud sounds tolerable. This
will convince the Client and third party that the hearing instruments are really working, and that it is worthwhile going
through the trouble of getting used to them.
All of this you can achieve by using live spectrum illustrations in the audiogram, showing the degree of audibility for familiar real life sounds with and without hearing loss, or with and without amplification. You can use both live sounds and
recorded sound files for this purpose.

Noise reduction, directionality, feedback
In addition to this, you can use the system to demonstrate hearing instrument features such as
•

Noise reduction

Hearing Instrument feature demonstration: Noise Reduction ► 60
•

Directionality

Hearing Instrument feature demonstration: Directionality ► 61
•

Identifying acoustic feedback

Hearing Instrument troubleshooting: Feedback ► 62

5.1.3

The Counseling and Simulations fitting process milestones
The following milestones will be reached if you use a protocol appropriate to your Counseling and Simulations Module.
These milestones will improve the chances that the Client will adapt to using the hearing instruments and eventually
become satisfied with the result. Detailed descriptions of the following steps are provided in this guide.
•

Understanding the audiogram
The Client understands his/her own audiogram and the concept of residual dynamic range (the "area of opportunity").

•

Understanding the speech banana
The Client understands the speech banana and understands that the Counseling and Simulations spectrum needs to
"reach" the area of the banana where the speech "letter" is represented in order to be audible.

•

Improved speech audibility
The Client is convinced that the hearing instruments provide speech audibility that is not possible without hearing
instruments.

•

Handling binaural loss
The Client understands that with a binaural loss, two hearing instruments are significantly better than one.

•

Dealing with Client expectations
The Client has reasonable expectations, and understands that the hearing instrument does not provide perfect hearing, but is an aid that improves the hearing situation combined with complementary strategies.

•

Amplification issues
It should be clear to the Client and third party that initially it may be preferable with a slightly reduced amplification
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in order to make the adaptation easier. The amplification will be increased later, and the speech mapping can be used
to set up new amplification goals.
•

Handing over responsibility to the Client
The responsibility for the fitting process is handed over to the Client when you have shown the Client that the hearing
instrument is appropriately fitted technically. It is then up to the Client and third party to train and adapt to the amplified sound.

The following sections describe different session elements you can use, either separately or combined, to form a complete
workflow.

The specific workflows
The Hearing Loss Simulator ► 47
The Hearing Instrument Simulator ► 51
Speech Mapping ► 53

Extra features
Hearing Instrument feature demonstration: Noise Reduction ► 60
Hearing Instrument feature demonstration: Directionality ► 61
Hearing Instrument troubleshooting: Feedback ► 62

Concluding a client session
Handing over the responsibility ► 63

5.2

The Audiogram
The Audiogram is a common prerequisite for using the Hearing Loss Simulator, the Hearing Instrument Simulator and
Speech Mapping.

From NOAH
Under NOAH the audiogram is shown automatically when you select a Client.

Stand-alone
You can plot in the Client’s audiogram in the Audiometry module. When you save the Client’s data, this audiogram is saved
as well.

5.3

The Hearing Loss Simulator
The purpose of the Hearing Loss Simulator
The purpose of the Hearing Loss Simulator is to illustrate to the Client and the third party the difference between hearing
as it is experienced by a person with normal hearing and hearing with the Client's own hearing loss.

Illustrating the difference between normal hearing and a hearing loss
You can illustrate the difference both by using the graphics of the audiogram and by playing sounds (to the third party) that
are changed according to the audiogram. In this way, the current hearing loss can be experienced and understood by others than just the Client. You can also use an audio-visual combination to show the audibility in real time, using the live
spectrum.
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Environmental compensation
When simulating the impact of a specific hearing loss the effect can in some cases be perceived as to aggressive.
The reason is that the entered hearing loss related to the level of the sound file that is being played will result in simulations with a very low speaker output.
This low speaker output could “drown” in the environmental background noise in an ordinary office environment. Also,
the low speaker output will further suffer by even a small hearing loss in the “normal hearing” listener.
In other words the HLS will simulate the precise effect of a given hearing loss only if it is used in a sound treated environment (such as a sound booth) and if the listener has 0 dB HL hearing thresholds.
This seemingly exaggerated simulation is most obvious when demonstrating the effect of hearing loss near the hearing
threshold.
To compensate for the environmental background noise and a small hearing loss of the “normal hearing” listener, a compensation factor is available in the HLS option setting. This compensation is not just an offset of the output. The HLS model
will incorporate the factor in the actual simulation related to hearing loss and sound level.
A stronger ‘Environmental compensation’ will increase the output of the simulation for a given hearing loss.

Environmental compensation:
•

None

•

Mild (Default setting)

•

Moderate

•

Strong

•

Very strong

Starting the process
Use the Hearing Loss Simulator to explain the audiogram, and explain the speech banana and illustrate which sounds are
inaudible. This will give the Client and the third party the necessary understanding in order to start and motivate the process towards improving their hearing situation and communication.

Visualizing audibility
The time spent on using the Hearing Loss Simulator early in the rehabilitation process is also worthwhile because it introduces the Client and third party to the concepts of visualizing audibility. You will be using this as a convincing pedagogical
tool throughout the rest of the fitting process.

5.4

Suggested HLS workflow
Use the Hearing Loss Simulator or the Speech Mapping functions to make an efficient and in-depth description of the audiogram.
It is recommended that you primarily use the Hearing Loss Simulator for this purpose since it provides a simulation of the
hearing loss for the third party and does not require probe measurements for the illustration.
Both approaches are described (Explain/repeat the audiogram using Speech Mapping ► 56).
1. Interview the Client in order to establish the Client’s level of understanding and determine which important every-day
situations that are in need of improved communication for the Client.
2. Start up the Hearing Loss Simulator.
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3. Tell the Client and third party that you would like to illustrate the difference between the hearing the Client used to
have, and the Client's hearing today (formulated this way of course presupposes that the Client’s hearing has at some
point deteriorated from initially being normal, as with common presbyacusis).

5.4.1

Explain the audiogram
Explain the audiogram graph representation of sound amplitude (loudness) and frequency (pitch)
1. In Normal mode, start without using any overlays except "Counseling and Simulations" (FFT Spectrum).
2. Explain the representation of the two axes, and play the "Flute" sound file through the loudspeakers.
3. Point out how the different tones are represented on the frequency axis, and the loudness of the sound is represented on the dB axis.
4. Use one of the “Voices only” files to illustrate that many "tones" of different frequencies combine in everyday sounds,
such as speech.
5. This step may be included depending on the level of understanding:
Use the Pictures overlay to illustrate how different sounds can be represented depending on what they sound like in
terms of loudness and frequency content. You can combine this with a short sound sample that clearly illustrates the
same as one or two of the pictures (e.g. "Handmixer" and "Bird").

5.4.2

Explain the audiogram threshold curve
Explain that the audiogram is used to show how loud different frequencies need to be in order to be just barely heard or
perceived as uncomfortably loud by the Client, and the resulting dynamic range
1. In Normal mode, point out the curve at 0 dB HL and explain that this is the lowest level that people with normal hearing can hear.
Also point out the normal uncomfortable loudness level (UCL) curve at 110 dB HL and explain that this is the level
where normal people typically think it is painfully loud.
2. Apply the "Unused area" overlay to illustrate the hearing range ("area of opportunity") of normal hearing.
Explain that sounds must exceed the thresholds to be audible and that sounds exceeding the uncomfortable loudness
levels will be perceived as painfully loud.
3. Switch to Simulated mode, and show the Client's own hearing thresholds and uncomfortable loudness levels.
Explain that sounds must be louder than normal to be heard by the Client (and, in case of a typical sloping audiogram,
differently loud depending on whether the sound is low pitched or high pitched).
4. Point out that the area between the thresholds and uncomfortable loudness level is smaller than normal, and that
sounds do not have the same room to vary in strength between being "just heard" and being painfully loud.
The problem of weak sounds being difficult to hear is thereby not the only problem associated with hearing loss. It is
also difficult to make sounds sufficiently loud without being uncomfortable.

5.4.3

Simulate the client's hearing loss for the third party
Simulate the Client's hearing loss for the third party through the loudspeakers/headphones in order to reinforce the need
for support and joint efforts to overcome the difficulties associated with the impaired perception.
1. Select an appropriate sound file, either a piece of music or recorded speech. If you are doing this demonstration
before introducing the speech banana, sounds other than speech may be preferable - saving speech for later.
2. Start with either Normal or Simulated mode, and then toggle between them after a few seconds in each mode.
Indicate when you change between the two modes.
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3. Point out how the sound (the spectrum) is above or below the thresholds depending on the configuration of the audiogram.

In case of a typical high-frequency loss, point out that the sound is "muffled" due to the lack of high frequency sensation.

5.4.4

Set expectations
Set reasonable expectations regarding the use of hearing instruments.
1. Explain that hearing instruments will not provide normal hearing, but will improve audibility and improve hearing in
important listening situations. This means that hearing instruments are not like eye-glasses that can fully compensate
for the loss of function.
2. Select the Simulated mode, and play a sound file.
While you play the sound file, improve the thresholds one by one, to a level of about half of the original hearing loss.
3. Continue playing, and explain that while this amplification is much better than the hearing loss, it is not as good as normal hearing.
4. While playing, switch to Normal mode, and toggle a couple of times between Normal and Simulated mode.
5. Before you revert to the original audiogram, remain for a moment in Simulated mode and make it clear that this is not
perfect, but it is certainly better than with the hearing loss - and then reload the original audiogram.

5.4.5

Introduce the speech banana
Introduce the speech banana and explain the individual "target" speech banana
1. In Normal mode, select the "Speech banana" and "Speech letters" overlays.
Explain that conversation speech sounds need to reach this area in order to be clearly heard if the hearing is normal.
2. Switch to Simulated mode and point out how part of the speech sounds will be inaudible with this hearing loss. It is
not enough that conversational speech sounds reach the normal speech banana for speech to be audible.
3. Switch to the "Customized” speech banana, which recalculates the speech banana according to the dynamic range of
the current audiogram.
Explain that this is the personal speech banana which the different speech sounds must "reach" in order to be audible.
Also, point out that the purpose of a hearing instrument is to amplify the speech sound so that it "reaches" the levels
of this personal area.
4. Play the sound-file "Speech banana sound" and show how the speech reaches the normal speech banana, but fails to
reach important parts of the "Personal speech banana" in the Simulated mode.
To illustrate this, switch between Normal and Simulated mode, or switch the "Personal speech banana" recalculation
on and off.
Also, mention which sounds will be difficult to hear according to the displayed speech letters.

5.4.6

Concluding the Hearing Loss Illustration demonstration
After going through these steps with the Hearing Loss Simulator, the Client and third party will have gained a useful experience as well as good understanding of the audiogram and the speech banana.
This will be useful in the following procedures, when you use the Hearing Instrument Simulator and especially when you
continue with the Speech Mapping part.
A good understanding of the needed amplification and how it is illustrated by the spectrum in Speech Mapping is fundamental in order for the Client and third party to realize that the goal for the fitting has been achieved.
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This understanding, paired with the involvement of the third party is likely to make the acclimatization period easier, and
to improve the chances of the Client actively using the hearing instrument in everyday life.
It is important that you repeatedly reinforce these illustrated key aspects of hearing and hearing deficit throughout the
entire fitting process.

5.5

The Hearing Instrument Simulator
The purpose of the Hearing Instrument Simulator
The purpose of the Hearing Instrument Simulator is to illustrate (primarily) to the Client what difference it makes to different sounds when the Client uses a basic non-linear hearing instrument.

Illustrating the use of a hearing instrument
You can illustrate this both by using the graphics of the audiogram and by playing sounds that are amplified according to
the client's audiogram (according to NAL NL-1). That way, you can improve the understanding of amplification without the
need for a real hearing instrument being fitted. Also an audio-visual combination is used to show the improvement in audibility in real time, using the live spectrum.

Starting the process
When you use the Hearing Instrument Simulator to explain the benefit of amplification, you eliminate the common stigma
that is often associated with the first time using hearing instruments. This will allow the Client to experience an improvement in audibility without being concerned about what it looks like. It is also a straightforward way of illustrating the sensation of binaural fitting as opposed to the use of a single hearing instrument.

Visualizing audibility
Using the Hearing Instrument Simulator in the rehabilitation process is worthwhile also because it reinforces the concepts
of visualizing audibility that is used as a convincing pedagogical tool throughout the fitting process.

5.6

Suggested HIS workflow

5.6.1

Prerequisites
•

Understanding the audiogram
The audiogram must be well understood by the Client and third party. It is recommended that you first go through
explanations using the Hearing Loss Simulator. See Suggested HLS workflow ► 48.
Further emphasis on the dynamic hearing range, speech banana and spectrum may be necessary throughout the session.

•

Visualizing
The Predicted Aided Audiogram view, "Unused Area" overlay, and the recalculated "Customized" speech banana overlay are appropriate complements to emphasise the visual impression of this exercise. It may also be considered
whether to use dB HL or dB SPL graphs for the Hearing Instrument simulation.

•

Select the Hearing Instrument Simulator screen.

•

Tell the Client and third party that you will demonstrate how hearing can be improved by amplifying sounds. The
sound in the headphones will be alternated between being amplified and being played normally.

•

You may want to point out that real hearing instruments will be more carefully adjusted to suit the Client, but that
this is a rough demonstration of what hearing instruments do.

•

You can use the operator headset to monitor the simulation.
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5.6.2

Demonstrate how the sound is amplified and makes sound more audible
1. In Normal mode, start playing a file of e.g. music or speech (preferably without background noise). Alternatively, you
can use a custom recording (see Making and using custom recordings ► 32).
2. Switch to binaural Simulated mode which activates the amplification in both ears.
3. Point out how the spectrum in the graph is amplified and as a result reaches further above the thresholds when simulating.
You can use the Predicted Aided Audiogram view to illustrate that the aided thresholds are lower than the unaided
thresholds, which gives access to a greater part of the speech banana.
4. Toggle a few times between Normal and Simulated mode in order to reinforce the achieved improvement with amplification.
5. You can play parts of a few different sound files.

5.6.3

Explain that the amplification is tailored according to the audiogram
Online changes in the audiogram
You can make changes to the audiogram while you perform Hearing Instrument Simulation. These changes are immediately reflected in changes in the amount of amplification. You can use this to illustrate how hearing instruments are specifically programmed according to different individuals' audiograms.

Fine tuning
Although useful for the purpose described above, using these changes of the on-screen audiogram for "fine tuning" is not
recommended. You should avoid "Fine tuning", as this may well confuse the Client and third party.

5.6.4

Demonstrate the benefit of binaural fitting
Demonstrate the benefit of binaural fitting in terms of sound quality perception
1. Select an appropriate sound-file, either a piece of music or recorded speech, and start the binaural simulation.
2. Alternate between binaural simulation and monaural right or left simulation.
Point out the difference between the two spectra in the two graphs when amplifying monaurally.
Ask the Client whether it sounds better with one or two hearing instruments.
3. You can complement this demonstration with some facts about the benefits of using two hearing instruments instead
of just one.
These benefits include

5.6.5

–

directional hearing,

–

better ability to understand speech in noisy conditions, and

–

avoiding the risk of late-onset auditory deprivation.

Concluding the Hearing Instrument Simulator demonstration
After going through these steps with the Hearing Instrument Simulator, the Client (and the third party) will have gained a
good understanding of the purpose of the hearing instruments as well as experienced what amplification may sound like.
A good understanding of the needed amplification and how it is illustrated on the screen is fundamental in order for the
Client and third party to realize what the goals are in the technical fitting process.

52

Otometrics - AURICAL Visible Speech

5 The Counseling and Simulations Module Workflow

5.7

Speech Mapping
The main purpose and the most important feature of the Speech Mapping module is to make it possible to demonstrate
the achieved audibility (primarily of speech) with and without a fitted hearing instrument.

The Speech Mapping concept
The concept is to place the probe tube in the Client's ear canal, and measure the sound pressure near the eardrum. The
resulting live spectrum is displayed in real time in the Client's audiogram. This allows for visually demonstrating the
degree of speech audibility, and visualizing that the desired improvement has been accomplished when the hearing instrument has been fitted.
It is imperative that the audiogram principles are thoroughly understood by the Client and third party to successfully reach
the desired outcome of the Counseling and Simulations Mapping approach.

Explaining the goal
Speech Mapping is used to explain the goal of the technical rehabilitation, as well as to demonstrate that this goal has
been accomplished.
The exercises will equip the Client and third party with the necessary assurance that wearing and getting used to the hearing instruments is well worth the effort.
Constructive personal involvement, during as well as after the fitting process, is as important as the hearing instrument
itself in order to actively retrain hearing with these new and improved but very different prerequisites.

5.7.1

The Speech Mapping Illustration
Speech Mapping aims to demonstrate that speech sounds that are amplified by the hearing instrument are audible, and
are presented within the Client's remaining hearing range.
This means that
•

the ear canal sound spectrum for soft speech should be above threshold,

•

comfort level speech sounds should be represented approximately up to the lower half of the hearing range, and

•

loud speech should always be below the uncomfortable loudness levels.

5.8

Suggested Speech Mapping workflows

5.8.1

Basic Speech Mapping measurements
The basic Speech Mapping measurements serve to convince the Client and third party that the hearing instrument makes a
big difference in making speech audible.

Comparing aided and unaided measurements
To achieve this, it is appropriate to compare unaided and aided measurements.

5.8.2

•

The unaided measurement will serve as a reference.

•

The aided measurement, compared with the unaided reference measurement, serves to illustrate the improvement
in audibility when the hearing instrument has been fitted.

Prerequisites
•

Understanding the audiogram
The Client and third party understand the Client’s audiogram well. Further emphasis on the dynamic hearing range,
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speech banana and spectrum may be necessary throughout the session.
•

The speech banana
Use the "Speech Banana" (customized), and the "Speech Letters" overlays for this exercise. The "Unheard Area" is a
recommended complement.

•

5.8.3

Use AURICAL Visible Speech, AURICAL SpeechLink 100 or AURICAL FreeFit
If you come directly from the Hearing Loss Simulator to this section, then place the device on the shoulders of the Client, and insert the probe tubes in the Client's ears. Open the Speech Mapping application and connect to the device
by activating the control panel.

Illustrate the lack of audibility using live speech
1. Explain that you will now illustrate how much of conversational speech sounds is being missed with the current hearing loss.
2. Select "Live" sound source.
3. Start a continuous unaided measurement (REUR) and talk while you point out how your voice does not sufficiently
reach the personal target speech banana.
In case of a typical audiogram, which slopes towards the higher frequencies, illustrate how the low frequencies reach
the banana so that your voice can be heard.
However, just hearing that a voice is present does not provide much information about what is actually being said. This
means that hearing only the low frequencies is not enough.
Point out that the high frequency speech sounds, where many of the speech details are represented, are not sufficiently audible. This is the reason why much of the speech information is lost.
4. Explain that hearing instruments will bring most of these inefficient sounds up to the levels of the “customized” personal target speech banana, and will thereby make more details of speech audible.

5.8.4

Illustrate how the hearing instruments improve audibility using live speech
1. Insert the preprogrammed hearing instruments in the Client’s ears, without altering the probe tube placement. Make
sure that the hearing instruments are activated.
For this exercise, it is recommended that the hearing instruments are programmed for an "experienced user" in order
to clearly demonstrate the benefit that will eventually be provided (see Acclimatization using Speech Mapping ►
60).
2. Start a continuous aided measurement (REAR) and talk to the Client.
If the hearing instruments are reasonably fitted from the start, it will now be apparent that the speech sounds are amplified so that at least parts of the aided measurement is reaching into the customized speech banana.
Point out this difference in audibility compared with the unaided measurement.
3. If the current fitting does not seem to provide the desirable amplification, then go through the procedures described
in Adjusting amplification using Speech Mapping ► 58.
4. When you have adjusted the amplification, you can demonstrate the satisfactory amplification for a few different
sound levels.
Explain that the hearing instruments provide sufficient amplification, and that it is now a matter of getting used to the
new sound (see Handing over the responsibility ► 63).
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5.9

Using a sound file for increased repeatability in Speech Mapping

5.9.1

Play a speech sample without amplification
Illustrate the lack of audibility without amplification using a conversational level 65 dB(A) speech sample that is played
through the loudspeakers.
1. Make sure the Client is comfortably seated facing the computer screen with the Left and Right loudspeakers at approximately 45 degree angles respectively. For details, see the description of Client placement for measurements using the
calibrated speakers, Positioning test equipment ► 18.
2. Inform the Client and third party that they will now see how much of the conversational speech that actually reaches
the personal speech banana without hearing instruments.
3. Select a speech signal.
Click Play to start a speech-only sound file and adjust it to read 65 dB SPL in the VU-meter. Use "Reset Peak Hold"
when you have reached the appropriate level.
Stop the sound file after a few seconds of undisturbed playback (use "Reset Peak Hold" if there is any unforeseen disturbance during the measurement).
4. Point out how parts of the measured speech level curve fails to reach important parts of the personal speech banana.
Also, if applicable, point out any part of the curve that is below the hearing threshold, and therefore cannot be heard
at all. It is of course imperative that speech is audible in order to be correctly perceived.

Using recordings

Note • As an alternative to the included sound files, you can use a recording of the spouse's/Significant Other's
voice for signal. This will further enhance the realism of this exercise.

If a recording has already been made, this sound file is available in the "Recording" sound source until the system is shut
down.
For a complete description of how to make an appropriate recording, see Making and using custom recordings ► 32.

5.9.2

Play a speech sample with amplification
Illustrate how the hearing instruments improve audibility using a conversational level 65 dB(A) speech sample that is
played
through the loudspeakers.
1. Take care not to change the position of the inserted probe tubes. Place the pre-programmed hearing instruments on
the Client's ears.
2. Make sure that the hearing instruments are activated.
It is recommended that the hearing instruments are programmed for an "experienced user" in order to clearly demonstrate the benefit that will eventually be provided.
If required, you can discuss and apply an acclimatization approach. See Acclimatization using Speech Mapping ► 60.
The gradual increase of gain throughout the acclimatization period may of course also be demonstrated using the
speech mapping over the coming visits. This will encourage the Client to reach the next goal by continuing the "training" using the new settings.
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3. Select the "Live" sound source and say a few words to the Client to just briefly check that there is reasonable amplification provided. The spectrum on the screen is now showing the sound that is being presented at the eardrum.
4. Switch back to "File" source, and start the same file used for the unaided measurement.
Stop the sound file after a few seconds of undisturbed playback (use "Reset Peak Hold" if there is any unforeseen disturbance during the measurement).
5. If the hearing instruments are reasonably fitted from the start, it will now be apparent that the speech sounds are amplified so that at least parts of the aided measurement is reaching into the personal speech banana.
Point out this difference in audibility compared with the unaided measurement.
6. After these more controlled measurements, it is appropriate to keep a "live" source measurement going for a while,
while you talk with the Client and third party, in order to catch any instances of speech sounds exceeding the uncomfortable levels.
This is also a good way for the Client and third party to get a good experience of the visualization of speech provided
by the Speech Mapping application.
It is also a good idea to play a few sound examples to make sure that sounds do not exceed uncomfortable levels.
Appropriate sound files would be e.g. "Washing up", "Keys" or “Newspaper”.
7. If the current fitting does not seem to provide the desirable amplification, then go through the procedures described
in Adjusting amplification using Speech Mapping ► 58.

5.9.3

Make additional measurements using soft and loud sound examples
1. Select a speech signal to demonstrate that soft sounds are audible.
2. Click Play to start the speech-only sound file and adjust it to read 50 dB SPL in the VU-meter. Use "Reset Peak Hold"
when you have reached the appropriate level.
The target typically used for this approach is the lower limit of the modified speech banana.
Stop the sound file after a few seconds of undisturbed playback (use "Reset Peak Hold" if there is any unforeseen disturbance during the measurement).
3. Select a loud signal such as "Handmixer" to demonstrate that loud sounds are tolerable, and adjust it to read
80 dB SPL in the VU-meter. Use "Reset Peak Hold" when you have reached the appropriate level.
To be tolerable, the sound must not under any circumstances exceed the uncomfortable loudness level (the UCL
curve). If this is the case, reduce amplification for high input levels in the hearing instrument program.
4. If the current fitting does not seem to provide the desirable amplification, then go through the procedures described
in Adjusting amplification using Speech Mapping ► 58.
5. When you have adjusted amplification, you can demonstrate the satisfactory amplification for a few different sound
levels.
Explain that the hearing instruments provide the sufficient amplification and utilise the Client's "Area of opportunity",
and that it is now a matter of getting used to the new sound (see Handing over the responsibility ► 63).

5.10

Explain/repeat the audiogram using Speech Mapping
Note • An in-depth explanation of the audiogram is efficiently made using the Hearing Loss Simulator or the
Speech Mapping application.
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It is recommended that you primarily use the Hearing Loss Simulator for this purpose since it provides simulation of the
hearing loss for the third party, and does not require probe measurements for the illustration.
An alternative procedure for explaining the audiogram in conjunction with the unaided Speech Mapping is however
described in Explain the audiogram ► 49.
Even if you use the Hearing Loss Simulator to initially explain the audiogram, you can also use the description in Explain
the audiogram ► 49, or parts thereof, as a guideline for repetition in conjunction with other speech mapping exercises.

5.10.1

The goal of this section
After going through your explanation of the audiogram and speech banana, the Client and the third party will have gained
useful experience as well as a good understanding of the audiogram, the speech banana, and the spectrum representation
of sound reaching the ear.
This will be necessary when using the Speech Mapping to illustrate the improvement provided by the hearing instruments.

5.10.2

5.10.3

Prerequisites
•

Tell the Client and third party that you would like to illustrate how the audiogram works and how it shows which
sounds the Client can and cannot hear.

•

Place AVS/SpeechLink/FreeFit on the Client, and insert the probe tubes in the Client's ears.

•

Open the Speech Mapping application and connect to the device by opening the control panel.

Explain the audiogram
Explain the audiogram graph representation of sound amplitude (loudness) and frequency (pitch)
1. Start without using any overlays.
2. Select the "Live" sound source in the control panel and press Play.
The probe microphone spectrum is now showing in the audiogram graph on the screen.
Illustrate pitch by using the appropriate tools, such as tuning forks of different pitch, or by playing the "Flute" sound
file through the loudspeakers.
Explain the representation of the two axes by pointing out how the different tones are represented on the frequency
axis, and the loudness of the sound is represented on the dB axis.
3. Say a few speech sounds such as "aaaaa", "eeeee", "sssss" to illustrate how different frequencies combine into complex sounds such as speech.
4. This step may be included depending on the level of understanding:
Use the pictures overlay to illustrate how different sounds can be represented depending on "what they sound like" in
terms of loudness and frequency content. You can combine this with a short sound sample that clearly illustrates the
same as one or two of the pictures (e.g. "Handmixer" or "Birds").

5.10.4

Explain the audiogram threshold curve
Explain that the audiogram threshold curve is used to show how loud different frequencies need to be to be heard - Also
explain that the Un-Comfortable Loudness (UCL) curve shows what levels the Client perceives uncomfortably loud. Explain
the resulting dynamic range of hearing.
1. Point out 0 dB HL and explain that when the spectrum reaches this level, this is the lowest sound that people with
normal hearing can typically hear.
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Also, point out the normal uncomfortable loudness level at about 110 dB HL and explain that when the spectrum
reaches this level, people with normal hearing typically think that the sound is uncomfortably or even unbearably
loud.
2. Apply the "Unused area" overlay to illustrate the Client's hearing range ("area of opportunity").
Explain that sounds must exceed the thresholds to be audible to the Client, and that sounds exceeding the uncomfortable loudness levels will be perceived as uncomfortably loud.
3. Point out that the area between the thresholds and uncomfortable loudness level is smaller than normal, and that
sounds do not have the same room to vary in strength between being "just heard" and being uncomfortably loud.
The problem of weak sounds being difficult to hear is thereby not the only problem associated with hearing loss. It is
also difficult to make sounds sufficiently loud without being uncomfortable.

5.10.5

Introduce the speech banana
Introduce the speech banana and explain the individual "target" speech banana.
1. Remove the "Unused Area" overlay and select the "Speech banana" and "Speech letters" overlays.
Explain that conversation speech sounds need to reach this area in order to be clearly heard if the hearing is normal.
2. Add the "Unused Area" overlay and point out how part of the speech sounds will be inaudible with this hearing loss.
It is not enough that conversational speech sounds reach the normal speech banana for speech to be audible.
3. Switch to the "Customized" speech banana (which recalculates the speech banana according to the dynamic range of
the current audiogram).
Explain that this is the personal speech banana which the different speech sounds must "reach" in order to be audible.
Also, point out that the purpose of a hearing instrument is to amplify the speech sound so that it "reaches" the levels
of this personal area.
4. While you talk, point out that the speech reaches the normal speech banana, but fails to reach important parts of the
"Customized" speech banana as soon as speech is at normal conversational levels.
This is illustrated by switching between the "Customized" speech banana recalculation on and off.
Also, mention which sounds will be difficult to hear according to the displayed speech letters.

Note • The demonstration of speech in relation to the speech banana in this section will not be appropriate
unless the probes are inserted in the Client's ear so that the ear-canal resonances are added to the spectrum.
Otherwise, the speech sounds will probably not reach the normal speech banana appropriately.

5.11

Adjusting amplification using Speech Mapping
When you use speech mapping for fitting a hearing instrument, the target provided on the screen is the personal speech
banana, which is the Long Term Average Speech Spectrum (LTASS) + standard REUG corrections that has been scaled in
relation to the residual dynamic range of the hearing. This means that the “Customized” speech banana illustrates normalized loudness.

The procedure
The general procedure for adjusting the gain according to this target is divided into three aims:
1. The ear canal sound spectrum for soft speech should be above threshold.
2. Comfort level speech sounds should be represented approximately up to the lower half of the hearing range.
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3. Loud sounds should always be below the uncomfortable loudness levels.
If the current fitting does not seem to provide the desirable amplification, you can conduct a real ear measurement using
traditional in-situ measurement equipment and adjust the insertion gain to match that of the pre-selected target (the target prescribed by the hearing instrument manufacturer). This is likely to provide sufficient gain to make the speech mapping demonstration visually meaningful.
Another approach is to simply adjust the hearing instrument gain while measuring the response in the Speech Mapping
module. With programmable hearing instruments you can easily do this by using the Speech Mapping On Top mode.

5.11.1

Suggested Speech Mapping On Top mode workflow
This functionality launches Speech Mapping floating over the hearing instrument manufacturer fitting software (or any
other software running on the computer). It also makes it possible for you to adjust the parameters of the hearing instrument and at the same time monitor the impact of the changes in the Speech Mapping graphs.

Prerequisites
Fulfilling the following prerequisites allows you to make adjustments to the hearing instruments simultaneously with the
Speech Mapping measurements. This includes switching on and off hearing instrument features, adjusting gain and compression parameters, etc.
•

Use the "Speech Banana" (Customized) overlay for this exercise.

•

Make sure that AVS/SpeechLink/FreeFit is turned on, placed on the Client, and the probe tubes are correctly inserted
in the Client's ears.
Also make sure that the hearing instruments are in place, and connected to the PC in the applicable manner.

1. Activate "Speech Mapping On Top mode" using the On Top toolbar button
2. Connect to the device by activating the Control Panel.
3. Launch the fitting software for the hearing instrument that you wish to adjust.
4. Make sure that you have established a connection between the hearing instruments and the hearing instrument fitting software.

Adjusting the amplification
1. Select one of the appropriate sound files to represent a soft-, conversational-, or loud level.
The level selected for the signal should correspond to the level of the gain parameter to be adjusted in the fitting software.
If you wish to adjust the gain for 50 decibels inputs, then you should play the sound signal at 50 decibels.
You can monitor the level of the signal in the reference microphone VU-meters above the Speech Mapping graphs.
2. Play the sound files one after the other, and make the proper adjustments to the applicable hearing instrument parameters in order to fulfil the three aims:
–

The ear canal sound spectrum for soft speech (typically 50 dB SPL) should be above threshold.

–

Comfort level speech sounds (typically 65 dB SPL) should be represented approximately up to the lower half of
the hearing range.

–

Loud sounds (typically 80 dB SPL) should always be below the uncomfortable loudness levels.
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5.12

Acclimatization using Speech Mapping
It may take quite some time for an unexperienced hearing instrument user to get used to, and fully utilise, the benefit of
amplification.
It is not unusual that Clients complain about the emphasis of certain frequencies - mostly in the range where the hearing
deficit has been most pronounced for a long period of time.
The hearing loss has typically been present for several years, and the Client may not be used to hearing much in a certain
frequency range.

The commonly used strategy
One commonly used strategy is to start out with slightly less amplification than what is judged to be needed for the Client's hearing loss.
This approach will make it easier for the Client to get through the process of getting used to wearing the instruments, and
increase the chances of the instruments being fully accepted and appreciated.
A reasonable approach is to apply a response that is mid way between the response preferred by the Client, and the
response that is believed to best accommodate for the Client’s hearing loss.
Experience shows that in due time, after about a month of hearing instrument use, the Client is likely to accept a higher
amount of gain, which better relates to the amount of hearing loss present.

Explaining the strategy
You can use Speech Mapping to explain this strategy to the Client, and show how you reduce the gain of the hearing instrument to make it more comfortable as a starting point.
Then you can use the Speech Mapping in consecutive sessions to set new goals with more amplification for the Client to
get used to, until eventually the final goal has been reached.
An acclimatization procedure is often available as a feature in the hearing instrument manufacturer's fitting software to
facilitate the programming.

5.13

Hearing Instrument feature demonstration: Noise Reduction
If you use the PMM module, you can use the Noise Reduction test screen in PMM to verify and demonstrate the hearing
instrument’s noise reduction functionality. (See the PMM user manual for more information.) Otherwise, you can use the
following workflow.
The Noise Reduction feature in contemporary hearing instruments typically requires quite a few seconds (often 15-20
seconds) of steady noise before it is able to start the attenuation.
The reference measurement is simply made during the first few seconds before the Noise Reduction starts attenuating.
Then a second curve is recorded where the signal is sufficiently long lasting to activate the reduction.
Thus it is judged that the illustration of Noise Reduction can be carried out without switching the reduction on and off.

Note • Make sure that the Noise Reduction feature is available in the hearing instrument.

If you wish to do the reference measurement with the Noise Reduction switched off altogether, it is recommended that
you do the following measurements in On Top mode (see Suggested Speech Mapping On Top mode workflow ► 59.
This makes it easy to access the hearing instrument Noise Reduction controls.
The Noise Reduction feature is typically most effective in the lower frequencies in order to reduce masking effects.
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The reduction is not very impressive visually in the graph, since it is typically only a matter of 3-5 decibels of attenuation.
This is however a very powerful auditory improvement, since it makes a significant difference in improving the signal-tonoise ratio, which is especially critical for the hearing impaired.

5.13.1

5.13.2

Prerequisites
•

Place AVS/SpeechLink/FreeFit on the Client, and insert the probe tubes in the Client's ears.

•

Place the hearing instruments in the Client’s ears, and activate them.

•

Open the Speech Mapping application in Counseling and Simulations and connect to the device by activating the control panel.

Illustrate the effect of Noise Reduction
1. Explain that you will now illustrate how the hearing instrument will detect steady noise, and after a while attenuate
that noise.
2. Select "File" sound source, and select the file "Car ride" or "Pink noise."
3. Either disable the hearing instrument Noise Reduction, or make sure that the measurement in the next step is sufficiently short not to trigger the noise reduction.
4. Instruct the client not to change position during the following measurements.
5. This first measurement is the reference. The resulting curve will show how the noise is amplified without Noise Reduction. Start the measurement, and let it run for about three seconds before stopping it.
6. Make sure that the Noise Reduction is activated, and start another measurement. Let it run for 15-20 seconds, and
look for the decrease in the spectrum.
7. Reset Peak Curve before you stop the measurement. That way the suppressed peak level will be stored instead of the
initially registered unsuppressed peak curve.
8. Compare the two curves. Explain to the client that the upper curve in the SPL graph is the amplified noise without
Noise Reduction, and the lower curve shows the small but very important reduction of noise after the hearing instrument adjusts to the noise.

5.14

Hearing Instrument feature demonstration: Directionality
Directional microphones work best when the competing unwanted sound is behind the hearing instrument user.
It is very important that the distance between the Client’s ears and the loudspeakers is maintained throughout this exercise. This is particularly crucial because the client will be turned away from the loudspeakers half way through the exercise. The measurements before and after turning the Client will be compared.
The effect of directionality is not very impressive visually in the graph, since it is typically only a matter of a couple of
decibels of attenuation. This is however a very powerful auditory improvement, since it makes a significant difference in
improving the signal-to-noise ratio, which is especially critical for the hearing impaired.

5.14.1

Prerequisites
•

Place AVS/SpeechLink/FreeFit on the Client, and insert the probe tubes in the Client's ears.

•

Place the hearing instruments in the Client’s ears, and activate them.

•

Open the Speech Mapping application in Counseling and Simulations and connect to the device by activating the control panel.
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•

Explain that you will now illustrate how the hearing instrument will attenuate the disturbing sound that comes from
behind the client.

•

Select "File" sound source, and select the file "Classical music".

•

Make a reference measurement when the client is facing the loud speakers. Measure for about five seconds before
you stop the measurement.

•

Turn the Client around so that the music will now reach the Client from behind. Make sure that the distance between
the hearing instruments and the loud speakers is not changed.

•

Start another measurement using the same sound file, and measure for the same length of time as the first measurement.

•

Compare the two curves.
Explain to the client that the hearing instrument will prioritize sounds that come from the front.
The upper curve in the SPL graph is the amplified signal when facing the sound source.
The lower curve is the result when the hearing instrument determines that the sound comes from behind and is considered a disturbing sound.

5.15

Hearing Instrument troubleshooting: Feedback
When you use the spectrum in its fine 1/24 octave resolution, you can pinpoint any acoustic feedback that is present in
the fitted hearing instrument. This makes it possible to objectively identify the feedback and verify the efficacy of the remedy.
Also, measuring in the ear makes it possible to detect feedback before it is even heard by the Client or the people around.

5.15.1

5.15.2

Prerequisites
•

Place AVS/SpeechLink/FreeFit on the Client, and insert the probe tubes in the Client's ears.

•

Place the hearing instruments in the Client’s ears, and activate them.

•

Open the Speech Mapping application in Counseling and Simulations and connect to the device by activating the control panel.

Objectively detect acoustic feedback
1. Start the Speech Mapping measurement using the "Live" signal source.
2. Make sure that the environment is as quiet as possible.
3. Inspect the spectrum, and look for any narrow peaks. A peak will indicate that there is a feedback tone present.
4. Stop the measurement.
5. When you move the mouse pointer across the graph, an indication of the grid co-ordinates expressed in decibels and
frequency is visible in the graph corner.
Move the mouse pointer to the detected peak, and check at which frequency the feedback occurs.
6. Make the proper adjustments to reduce the feedback.
7. Repeat the measurement for verification of the improvement.
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5.16

Handing over the responsibility

5.16.1

After the fitting process
Even though the dispenser of hearing instruments is responsible for delivering appropriate and well fitted hearing instruments to clients, it is imperative for a successful aural rehabilitation that the Client also takes responsibility for the re-training, or acclimatization process.
After the electro-acoustical fitting has been provided, and the dispenser has demonstrated to the Client that the hearing
instruments work as they should, it is time to hand over the responsibility for the continuing process.
The Client must now get used to the sound.

5.16.2

Remembering the benefits shown by the dispenser
Many hearing instruments are either returned to the dispenser for cash, or are left unused on the night stand.
A major reason for this is the fact that the Client (and third party) was not equipped with the necessary conviction and dedication to successfully follow through the process of getting used to the dramatic change in auditory perception.
The Counseling and Simulations approach aims at preparing the Client for this training process.

5.16.3

•

Even though the Client and third party cannot remember all the curves and graphs some time after the sessions, they
will remember that they have seen the clear benefit provided by the hearing instruments.

•

They will remember that the dispenser adjusted the hearing instruments to fit the individual hearing loss, and that it
worked.

•

They will also rely on the feeling of conviction they experienced with the illustrations and explanations.

Getting used to the sounds
Amplification can be annoying
During the first period of using hearing instruments, the benefits of the amplification are often contrasted by the annoying
audibility of natural sounds which the Client may not have heard for many years (and even then these sounds were not
heard with the same sound quality as provided by hearing instruments).
This is new to the Client.

Do not start with too dramatic sound environments
Recommend the Client not to challenge the hearing with the most dramatic sound environments from the start, but rather
focus on the situations initially described as being those most important.
Alternatively, the Client may well choose to consider the easier of those situations as a first step, before moving on to
more difficult environments.

5.16.4

Getting used to the sounds takes time
The period of adaptation
Inform the Client that the process of getting used to the increased audibility, which you have demonstrated, will take
some time.
The time frame of adaptation differs from person to person.
Also the experienced difficulty will vary between individuals.
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The first two weeks
The first two weeks are very critical for a first time user.
It is often even recommended that the Client has some sort of coaching during this period. That is one good reason for
involving a family member or friend in the counselling and fitting process.

What are the expectations?
After 6 to 12 weeks, it has been described in the literature that additional acclimatization starts taking effect. This additional acclimatization significantly improves the user’s aided hearing.
It has also been described that for elderly first time users, it may take up to a year of active use before the user optimally
benefits from the hearing instruments.

5.16.5

Fine tuning
Of course it cannot be pre-supposed that there will be no more fine tuning involved, or that the client will be totally
happy with all the settings.
There might be a need for an additional program, or even utilizing an acclimatization routine, in which it is decided to start
out with a little less amplification.
Counseling and Simulations is then a good tool to set up new goals of increased amplification from time to time, so as to
eventually reach the optimal amplification. This is a good way to verify a final closure of the whole fitting process.
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Service, Cleaning and Maintenance

6.1

Equipment failure
Warning • Do not use a defective device.

If you believe the correct function or operation safety of AVS to be faulty in any way, disconnect AVS from the power supply, remove the batteries, and make sure that it cannot be used by others until it has been serviced.

Warning • Under no circumstances disassemble AVS or AVS charger. Contact your supplier.

6.2

Service and repair
Warning • Under no circumstances disassemble AVS or AVS charger. Contact your supplier. Parts inside AVS or
AVS charger must only be checked or serviced by authorized personnel.

Warning • Do not disassemble the AVS charger as there is a risk of electric shock.

For the sake of safety and in order not to void the warranty, service and repair of electromedical equipment should be carried out only by the equipment manufacturer or by service personnel at authorised workshops. In case of any defects,
make a detailed description of the defect(s) and contact your supplier.
The manufacturer reserves the right to disclaim all responsibility for the operating safety, reliability and performance of
equipment serviced or repaired by other parties. Following repair, the equipment should be tested by suitably qualified
personnel.
On request, your supplier can obtain a Service Manual from the manufacturer. The Service Manual contains electrical diagrams, descriptions, lists of components and calibration information, etc.

6.2.1

Test device information
To see information relating to the test device, select Help > About...
If AVS is not connected, click Connect.
A screen will show you specifics relating to Bluetooth version, COM port, Hardware version, etc.

6.3

Cleaning
We recommend that you observe the guidelines below.
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AVS
AVS and its component parts are in constant contact with your clients so care should be taken to ensure that they are kept
clean and free from dust.
•

Use a soft, slightly damp cloth with a small amount of mild detergent or approved non-caustic medical grade disinfectant wipes to clean the unit and charger according to local infection control regulations.

Caution • Keep the unit away from liquids. Do not allow moisture inside the unit.

Caution • Never immerse the AVS probes into water or other cleaning solutions.

Caution • No part of AVS or it accessories is suitable for autoclaving or thermal disinfection/sterilization methods.

Silicone probe tubes, guides and cords
These parts are in constant contact with your clients.

A. Silicone probe tube
B. Silicone tube guide
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C.

Cord

•

Silicone tubes:
The only part which is inserted into the ear canal in VSM testing is the silicone tube. These tubes are disposable, and
should only be used once per client.

•

Guides and cords:
Use a soft, slightly damp cloth with a small amount of detergent to clean the cords and the silicone tube guides.
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Disposal
There are no special requirements regarding the disposal of the silicone probe tubes, i.e. they can be discarded according
to local regulations.

6.4

Maintenance
AVS and charger unit require no preventive maintenance.

6.4.1

Calibration
AVS and probes are calibrated at the factory.
•

The probe calibration values for the reference microphone are saved in the probe assembly and follow the probe.
Accordingly, it is not necessary to keep track of left and right probes. A probe can be plugged into any AVS and used
right away.

Annual calibration
The AVS device and probes must be calibrated once a year by your authorized service department.

6.4.2

Replacing a probe
Disconnecting the probe from AVS
1. Disconnect the probe from AVS. Grip the probe cable by the plug and free it by gently pulling it out of the socket. Do
not pull the plug by the cable.

Connecting the probe to AVS
1. Insert the probe plug of the new probe in the probe socket on the side of AVS. The arrow stamped on the plug must
face outwards when you insert the plug.

A. Probe plug in socket
B. Arrow
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6.4.3

Replacing an ear cord
The ear cords are mounted at the factory. If you need to replace an ear cord:
• Remove the old cord, if required.
•

Mount the new ear cord on the probe. To do so, pull on the rubber cord and slide it into the groove.

6.5

Troubleshooting

6.5.1

Powering problems
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Problem

Possible cause

Solution

AVS does not power on even though
I press the power button.

•

The battery is inserted incorrectly.

•

Insert the battery correctly.

•

The battery needs charging or replacing.

•

Charge the battery or fit AVS
with a new battery.

AVS powers off and cannot power on
even though I press the power button.

•

The battery needs charging or replacing.

•

Charge the battery or fit AVS
with a new battery.

The AVS status indicator does not
light up when I place AVS in the charger.

•

The charger is not connected to the
power adaptor, or the power adaptor
is not connected to the mains power
supply.

•

Connect the power adaptor
to the charger and to the
mains supply.

The AVS battery lifetime is very low
even though the battery has been
charged.

•

The battery is defect, maybe because
it is too old.

•

Fit AVS with a new
rechargeable battery.

The AVS status indicator changes
from amber (charging) to green (charging complete), very soon after I
place AVS in the charger.

•

An Alkaline battery has been inserted
in AVS.

•

Fit AVS with a new battery.

•

No battery is fitted in AVS.

•

The battery is defective.
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7.1

Unpacking
1. Unpack AVS carefully.
When you unpack AVS, it is a good idea to keep the packing material in which it was delivered. If you need to send
AVS in for service, the original packing material will protect against damage during transport, etc.
2. Visually inspect the equipment for possible damage.
If damage has occurred, do not put the device into operation. Contact your local distributor for assistance.
3. Check the packing list accompanying the package to make sure that you have received all necessary parts and accessories. If your package is incomplete, contact your local distributor.

7.2

Installing OTOsuite
Install OTOsuite from the OTOsuite installation disk. For instructions on installing OTOsuite, see the OTOsuite Installation
Guide, which you can find on the OTOsuite installation medium (disk or memory stick).

7.3

Storing AVS
If you need to store AVS before you put it into operation, follow the guidelines below:

7.4

•

Store AVS and accessories in the box provided to protect the equipment from damage.

•

Store AVS in a dry environment. See also Storing and handling ► 94.

Views of AVS and charger
AVS is designed to be placed around the shoulders of the client. It consists of a main unit and two REM probes which are
supplied with the unit. When not in use, it should be placed either in its desktop or wall-mounted charger.
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7.4.1

Front view

A. Device
B. Probes

70

C. Charger
D. Charger base plate
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A. Battery compartment
B. Status indicator
C. On/Off button
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D. Probe
E. Cord
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7.4.2

Reverse side view

A. Label

7.4.3

The charger
Front view

A. Charger tab for charging the

C.

Base plate

device
B. Power indicator
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Rear view

A. Charger socket

Otometrics - AURICAL Visible Speech

73

7 Unpacking and installing AVS and the Counseling and Simulations Module

7.4.4

The probes

A. Connector
B. Probe body
C. Silicone tube

7.5

D. Silicone tube guide
E. Cord

Assembly and installation
AVS is supplied partly assembled. To complete the assembly, see:

Instructions on how to assemble the charger
•

Charger assembly ► 75

•

Mounting the NOAHlink charger on the AVS charger base plate ► 77

Instructions on how to assemble the probe and tube
•

AVS and probe assembly ► 78

•

Fitting AVS with NOAHlink ► 80

•

Fitting AVS with counterweights ► 82

Powering instructions
•
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Powering AURICAL Visible Speech and connecting the device to OTOsuite ► 11
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7.5.1

Location
A sound cabin or sound treated room is not necessary, but it is recommended that you use a room where reverberation
time is not too long.
To ensure safe performance, the AVS must be correctly installed and the requirements listed in Safety - AURICAL
Visible Speech and the Counseling and Simulations Module ► 89 and Technical Specifications - AURICAL
Visible Speech ► 93 must be complied with.

Warning • Always keep the charger cradle away from the client area.

Warning • Keep AVS away from all liquids and sources of heat (for detailed specifications, see Operating environment ► 94.

Apart from the above warnings, AVS can be used with no specific requirements to location.

7.5.2

Charger assembly
Mount the charger on the base plate. You can choose between
• Base plate assembly ► 75
•

Wall mount installation ► 77

For use with NOAHlink, see
• Mounting the NOAHlink charger on the AVS charger base plate ► 77

Base plate assembly
Mount the charger on the charger base as shown below. This procedure applies both to desktop and wall mounting solutions.
1. Use the hexagonal key to screw the hexagonal screws into place as shown in the following.
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2. Make sure that you tighten the screws well so that the charger is stable when you place AVS in the charger.
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Wall mount installation

A. Locations for mounting 2 rawl plugs,110 mm (4.33”)
B. Wall mount back plate

1. Drill 2 x 6 mm diameter holes 110 mm (4.33") apart.
2. Insert rawl plugs.
3. Fit the screws through the back plate of the wall mount.

7.5.3

Mounting the NOAHlink charger on the AVS
charger base plate
If you plan to use AVS with NOAHlink (HIMSA’s product for hearing instrument fitting), you can attach NOAHlink to AVS.
Start by mounting the NOAHlink charger on the base plate of the AVS charger. See the following description.
1. Fix the mounting pads supplied with AVS on the bottom of the NOAHlink charger.
2. Remove the protective foil from the two adhesive pads and carefully place the NOAHlink charger on the AVS base
plate as shown below.
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3. For testing purposes you can fit NOAHlink on the AVS shoulder strap. See Fitting AVS with NOAHlink ► 80.

7.5.4

AVS and probe assembly
The AVS is designed for easy attachment of the probe(s) used during the test.

Fitting silicone tubes on the probes
A bag of silicone tubes is supplied together with AVS. The silicone tube is used for probe microphone measurement,
where it is inserted into the ear canal together with the hearing instrument. The silicone tube has a black marker ring for
marking how far into the ear canal the tube should be inserted.

A. Marker ring
B. Ear cord
C. Tube guide

D. Silicone tube
E. Probe housing

1. For test purposes fit a silicone tube to the thin metal tube at the top of the probe housing. Gently push and twist the
silicone tube down as far as possible over the metal tube.
It is much easier to fit and remove the silicone tube if you twist it gently. When you do so, make sure that you hold
the probe by the probe housing and not by the cable.
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Note • Accurate testing is only guaranteed if you use the silicone tubes designed specifically for AVS by
GN Otometrics A/S.

2. Repeat for the second probe housing, if required.

A. Probe housing
B. Silicone tube

C.

Tube guide

3. A tube guide can be attached to each probe. The tube guide is designed to hold the silicone tube in place in the ear.
Five tube guides are supplied with AVS.
The tube guide is easy to remove or replace: Grip the tube guide by the base and pull.
4. To adjust the ear cord simply pull to correct length for a comfortable fit over the client’s ear.

A. Ear cord

5. Repeat for the second probe housing, if required.

Fitting the probes on the AVS shoulder strap
When the probes are not fitted on the ears of the client, they are best kept on the shoulder strap of AVS for safe keeping.
1. Place AVS face up.
2. With the ear cord facing downwards, slide the probe housing into the grooves at the end of the shoulder strap.
3. Repeat for the second probe housing, if needed.
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A. Grooves

B.

Probe

4. To remove the probe housing, simply pull it out of the grooves.

7.5.5

Fitting AVS with NOAHlink
If you use AVS with NOAHlink (HIMSA’s product for hearing instrument fitting), attach NOAHlink to AVS. See the following
description.
When AVS and NOAHlink are not in use, they should each be placed in their charger cradle for charging. You can mount
the NOAHlink charger on the AVS charger. See Mounting the NOAHlink charger on the AVS charger base plate ► 77.
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Fitting NOAHlink

To attach NOAHlink to AVS, do as follows:
1. Remove the NOAHlink neck string from NOAHlink.
2. Attach the blue and red NOAHlink plastic attachment buttons on the end of the NOAHlink strap to NOAHlink.

Adjusting the NOAHlink straps
The length of the NOAHlink strap can be adjusted, if required. To adjust the length of the strap, pull the string loop to
loosen the string and then pull at either the end of the string or NOAHlink until the length is appropriate.
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A. Side view
B. Push string up through hole from below
C. Pull on short end of string to tighten

7.5.6

Fitting AVS with counterweights
If you use AVS without NOAHlink, attach the counterweights to AVS. See the following description. This will balance the
weight of AVS when it is placed on the shoulders of the client, to keep it from sliding off.
1. Place AVS facing downwards.

A. Counterweight

B.

Grooves

2. Slide the counterweight into the grooves at the end of the shoulder strap.
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A. Counterweight

3. Repeat with the second counterweight.

Removing the counterweights
•

7.5.7

To remove the counterweight, simply lift it out of the grooves.

Communication with Counseling and Simulations via Bluetooth
Communication via Bluetooth is established automatically from the Counseling and Simulations Module, when you wish to
use AVS.To set up the connection between Counseling and Simulations and AVS, you must run the Counseling and Simulations Configuration Wizard. For more information, see Configuring the Counseling and Simulations Module ► 85.

Note • AVS must be switched on to be able to communicate with the Counseling and Simulations Module.

Note • The Counseling and Simulations Module cannot communicate with AVS while the device is placed in the
charger and the power to the charger is connected.
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Configuring the Counseling and Simulations Module
The Counseling and Simulations configuration wizard guides you through the process of setting up Counseling and Simulations. You must run the configuration wizard before you can use Counseling and Simulations with AVS, SpeechLink or
FreeFit for the first time. You can also use the wizard later to change specific settings, or for example, to repair the connection between Counseling and Simulations and the test device.
1. Select Tools > Configuration wizard...
2. To connect your test device to the Counseling and Simulations Module and set up module-specific functionality, click
the Configure... button next to Counseling and Simulations .

AVS/SpeechLink/FreeFit
Connect to the device you wish
to use for testing.

1. Click on the device you wish to use.
–

If the device is not listed, check the check box My device is turned on
and ready to be found, and click Search.

–

If you are using a Bluetooth device other than OTOlink and you are having problems connecting to a device that is included in the list, click on
Repair.

–

If you continue to have connection problems, click Test to see the connectivity status. This may help you or the Otometrics support team to
diagnose connection problems.

2. A text states which Bluetooth connection is currently being used – the
OTOlink dongle, Microsoft Bluetooth stack, Widcomm Bluetooth stack, or
Unknown Bluetooth stack. If an OTOlink dongle is plugged in, it will always
be used.
If you always want to use the OTOlink dongle to connect to your AVS, select
the Use only OTOlink for device connection check box. Then you will
receive an error message if the OTOair is not plugged in.
For more information, see the “Connecting wireless devices” section in the
“Configuring OTOsuite” chapter, in the OTOsuite manual.
3. Click Next to continue the configuration or Finish to return to the Applications page of the configuration wizard.

Sound Card Selection
Specify your speaker setup and
select your preferred sound
devices (speaker output, headphone output, microphone
input, and speaker channel).

1. In the Speaker output, Headphone output and Microphone input fields,
select from the drop-down lists.
2. Specify the speaker channel to use for Counseling & Simulations. Select
either Left or Right to use one speaker, or Left + Right to use two speakers.
3. Click Next to continue the configuration or Finish to return to the main
Application Configuration window.
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Specify Calibration Method
Select the speaker calibration
method.

1. Click the relevant button to select, and then click Next.

Start Speaker Calibration
Perform speaker calibration.

1. Check the box My device is switched on and within reach and then click Next.
The calibration is performed, and then the calibration offset values are displayed.

2. Click Finish to return to the Applications page of the configuration wizard.
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The Rainbow Passage

When the sunlight strikes raindrops in the air, they act like a prism and form a rainbow. The rainbow is a division of white
light into many beautiful colors. These take the shape of a long round arch, with its path high above and its two ends apparently beyond the horizon. There is, according to legend, a boiling pot of gold at one end. People look, but no one ever
finds it. When a man looks for something beyond his reach, his friends say he is looking for the pot of gold at the end of the
rainbow.
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The Rainbow Passage

Otometrics - AURICAL Visible Speech

App. 2

Safety - AURICAL Visible Speech and the
Counseling and Simulations Module

This Guide contains information and warnings, which must be followed to ensure the safe performance of AURICAL
Visible Speech and the Counseling and Simulations Module. Local government rules and regulations, if applicable, should
also be followed at all times.

App. 2.1

Definition of symbols used
Electronic equipment covered by the Directive 2002/96/EC on waste electrical and electronic equipment
(WEEE).
All electrical and electronic products, batteries, and accumulators must be taken to separate collection at
the end of their working life. This requirement applies in the European Union. Do not dispose of these
products as unsorted municipal waste.
You can return your device and accessories to Otometrics, or to any Otometrics supplier. You can also contact your local authorities for advice on disposal.
Identifies the correct position of the battery inside the battery compartment.
Interference may occur in the vicinity of the device. Local regulations and precautions for other equipment in the environment should always be followed to avoid interference.
The separation distance from this device to other devices complying with standard immunity requirements in IEC 60601-1-2 is minimum 0.35 m/1ft.
Suitable for direct current only.
In France, it is only permitted to use the device indoors.

Consult user manual for warnings and cautions.

Follow instructions for use.

Consult instructions for use.

Complies with Type BF requirements of IEC60601-1.

Complies with Medical Devices Directive 93/42/EEC and RoHS Directive (2011/65/EC).
Complies with the Radio Equipment and Telecommunications Terminal Equipment Directive 1999/5/EC.
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The installation must be carried out in accordance with Medical Electrical Systems clause 16 in IEC 606011 (3rd), AAMI ES60601-1 and CSA C22.2 NO. 60601-1-08-CAN/CSA. The supplementary provisions on the
reliability of electro-medical systems.
It is a general rule for all electrical equipment used in the proximity of the client that:
•

The connected equipment must comply with IEC 60601-1 (3rd).

This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions:
•

This device must not cause harmful interference.

•

This device must accept any interference received, including interference that may cause undesired
operation.

The term”IC” before the certification/registration number signifies that the Industry Canada technical specifications were met.
Do not reuse.

Used in error message dialogs if software program fails. See the detailed information in the dialog box.

Manufacturer and date of manufacture.

App. 2.2

Warning notes

App. 2.2.1

Warning notes
AURICAL Visible Speech should only be provided with prescribed battery types, see Technical Specifications
- AURICAL Visible Speech ► 93.
Place the battery as indicated in the battery compartment, see Inserting the battery ► 12 for further details.
Use only rechargeable batteries when AURICAL Visible Speech is placed in the charger unit. If you are using an alkaline battery, do not attempt to charge your AURICAL Visible Speech. Your alkaline battery may be damaged and leak, and this may
in turn cause damage to AURICAL Visible Speech.
Batteries should be removed if equipment is not likely to be used for some time.
AURICAL Visible Speech should only be connected to the type 1053 Charger from GN Otometrics A/S.

Do not attempt to use AURICAL Visible Speech with clients while it is placed in the charger unit.

1. There are no user-serviceable parts inside the cabinet of the device or charger. For the sake of safety and in order not
to void the warranty, service and repair of electro-medical equipment should be carried out only by the equipment
manufacturer or by service personnel at authorized workshops. In case of any defects, make a detailed description of
the defect(s) and contact your supplier. Do not use a defective device.
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2. Keep the unit away from liquids. Do not allow moisture inside the unit. Moisture inside the unit can damage the
instrument and it may result in a risk of electrical shock to the user or patient.
3. Do not use the instrument in the presence of flammable agents (gases) or in an oxygen-rich environment.
4. Unwanted noise may occur if the device is exposed to a strong radio field. Such noise may interfere with the performance of the device. Many types of electrical devices, e.g. mobile telephones, may generate radio fields. We
recommend that the use of such devices in the vicinity of AURICAL Visible Speech be restricted.
5. Changes or modifications not expressly approved by the manufacturer could void the user's authority to operate the
equipment.
6. This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to
radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged
to try to correct the interference by one or more of the following measures:
–

Reorient or relocate the receiving antenna.

–

Increase the separation between the equipment and receiver.

–

Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

–

Consult the dealer or an experienced radio/TV technician for help.

7. For use in Canada: To prevent radio interference to the licensed service, this device is intended to be operated
indoors and away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.
8. No parts may be eaten, burnt, or in any way used for purposes other than the applications defined in the Intended Use
section of this manual.
9. The device and charger unit can be disposed of as normal electronic waste, according to local regulations. Please
investigate local regulations concerning the disposal of rechargeable and alkaline batteries.
10. For safety reasons, accessories connected to the equipment's outlet fittings must be identical to the type supplied
with the system.
11. It is recommended that an annual calibration be performed on accessories containing transducers. Furthermore, it is
recommended that calibration be performed if the equipment has suffered any potential damage (e.g. headphones
dropped on the floor).
12. To comply with EN 60601-1-1 computer and printer must be placed out of reach of the client, i.e. not closer than
approx. 1.5 meters/5 ft.
13. In the United States of America, Federal law restricts this device to sale by or on the order of a licensed physician.
14. It is recommended to install the unit in an environment that minimizes the amount of static electricity. For example,
anti-static carpeting is recommended.
15. The charger unit should be kept away from the client area.

Otometrics - AURICAL Visible Speech

91

App. 2

Safety - AURICAL Visible Speech and the Counseling and Simulations Module

App. 2.3

Manufacturer
GN Otometrics A/S
Hoerskaetten 9, 2630 Taastrup
Denmark
( +45 45 75 55 55
7 +45 45 75 55 59
www.otometrics.com

App. 2.3.1

Responsibility of the manufacturer
The manufacturer is to be considered responsible for effects on safety, reliability, and performance of the equipment only
if:
•

All assembly operations, extensions, re-adjustments, modifications or repairs are carried out by the equipment manufacturer or personnel authorized by the manufacturer.

•

The electrical installation to which the equipment is connected complies with EN/IEC requirements.

•

The equipment is used in accordance with the instructions for use.

The manufacturer reserves the right to disclaim all responsibility for the operating safety, reliability and performance of
equipment serviced or repaired by other parties.
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App. 3.1

AURICAL Visible Speech

App. 3.1.1

Interface
Wireless Bluetooth data transfer to PC, version 2.0 + EDR, class 2 (10 meters).

App. 3.1.2

Type identification
AURICAL Visible Speech is type 1053 from GN Otometrics A/S

App. 3.1.3

App. 3.2

Power supply
Battery types:

Rechargeable (Ni-MH type) AA (R6) 1.2V, 1 pc.
(Use only rechargeable battery supplied by GN Otometrics A/S)
Alkaline AA (R6) 1.2V, 1 pc.

Battery supply voltage:

Nom. 1.30 V,
Max. 1.65 V,

Min. start-up:

1.10 V (Measured with instrument load)

Min. when running:

1.00 V

Low battery indicator level:

When approximately 30 minutes of battery operating time remain.

Estimated battery life:

5 hours of continuous use. (This is based on a typical use scenario. The actual use
can influence the battery life time).

Mode of operation:

Continuous.

Charger unit
Type identification:

Charger unit is type 1053 Charger from GN Otometrics A/S

Nominal input voltage:

9 V DC

Min. input voltage:

6.5 V DC

Max. input voltage:

12 V DC

Max. power consumption while
charging:

300 mA (at 9 V input voltage)

Max. power consumption when
not charging:

60 mA (at 9 V input voltage)
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App. 3.3

Power adaptor

App. 3.3.1

Power supply
Input voltage range:

100-240 V AC, 50-60 Hz

Output voltage range:

9 V DC

Any IEC/UL 60601 or IEC/UL 60950 certified power adaptor supplying 9 V DC, min. 300 mA and with a maximum available
output of 15 W can be used.

App. 3.4

Operating environment
Temperature:

+15°C to +35°C (59°F to +95°F)

Rel. humidity:

30 to 90%, non-condensing

Warm-up time:

< 1 min.

Air pressure:

600 hPa to 1060 hPa

Operation at temperatures below -20°C or above +60°C may cause permanent damage.

App. 3.5

Storing and handling
Temperature:

-20°C to +60°C (-4°F to +140°F)

Rel. humidity:

< 90%, non-condensing

Air pressure:

500 hPa to 1060 hPa

App. 3.6

Dimensions
AURICAL Visible Speech (HxWxD):

23 mm x 350 mm x 230 mm
(0.91” x 13.7” x 9.1”)

Charger unit (HxWxD):

280 mm x 180 mm x 230 mm (11.4” x 7.1” x 9.1”) (with table plate mounted)

Charger unit (HxWxD):

340 mm x 180 mm x 230 mm (13.8” x 7.1” x 9.1”) (with wall plate mounted)

App. 3.7

Weight
AURICAL Visible Speech:

0.180 kg/0.40 lb

Charger unit:

0.700 kg/1.54 lb

App. 3.8
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Standards
Safety:

IEC 60601-1, UL 60601-1, CAN/CSA -C22.2 NO 601.1-90
AURICAL Visible Speech: EN 60601-1, Internally Powered, Type BF, IPX0

EMC:

IEC 60601-1-2, EN 300 328-2, EN 301 489-17
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preparing for testing 17
probe assembly 78
probes 74
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C
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assembly 75
desktop installation 75
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fitting AVS and probes for testing 22
inspecting the ear 22
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user interface 25
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Mapping 61
Dynamic range, explaining 49
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Firmware update, test devices 16
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Fitting process 46
handing over responsibility 63
Frequency, explaining 49
G
Getting started
AURICAL Visible Speech 69
H
Headphone calibration 21
Headphones 30
Hearing Instrument Simulator
simulated mode, HL 37
simulated mode, SPL 38
the HIS screen 37
Hearing instruments
new users 45
setting expectations 50
Hearing Loss Simulator
normal mode 36
simulated mode 36
the HLS screen 35
Hearing loss, explaining 49
HIS
main objective 51
suggested workflow 51
workflow prerequisites 51
workflow, binaural fitting 52
workflow, sound
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main objective 47
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Speech Mapping On Top
mode 42
Service and repair 65, 89
Settings
Control Panel 30
Shoulder strap
assembly 79
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from CD, Counseling and Simulations 31
from file, Counseling and Simulations 31
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Simulations 31
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using recordings, Counseling and
Simulations 32
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Hearing Instrument
Simulator 34
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Sound amplitude, explaining 49
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Mapping 56
Sound file
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